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About 
MacTerminal 

MacTerminaFM is an application that lets your Apple® Macintosh ™ computer 
communicate with other computers. The computers may be directly linked by 
a special cable, or remotely linked by some kind of transmission facility, most 
likely telephone lines. 

MacTerminal works on a Macintosh Plus, Macintosh, or Macintosh XL. 
If you have a Lisa 2/5 or 2/ 10, you need to upgrade to Macintosh XL by using 
MacWorks XL. See your authorized Apple dealer. 

With MacTerminal and the right equipment, you can send a table of figures to 
a coworker who has a Macintosh, Macintosh Plus, or Macintosh XL (or almost 
any other personal computer) ; to a client byway of an electronic mail service, 
like MCl MailsM, or a telex service, like Western Union EasylinkSM

; or to your 
company's mainframe computer half a continent away. You can get stock 
quotes and news from a service like Dow Jones News/ Retrieval®. Or you can 
gain access to whole libraries of information through various commercial data 
bases, such as CompuServe®, THE SOURCEsM

, and DIALOG®. 

About MacTerminal 
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About This Manual To use this manual , you need to know basic Macintosh techniques and 
operations. Before reading any further, if you have doubts about what windows 
are, what select means, or how you drag and click with the mouse, read 
Macintosh, your owner's guide. It also helps to be familiar with at least one 
other Macintosh application, such as MacWrite. 

Depending on how much you have used the Macintosh and other data 
communications software, you may want to start in different places in this 
manual. 

o If you have had little or no experience with data communications, turn to 
Chapter 1, "About MacTerminal," for an explanation of how MacTerminal 
helps you set up, carry out, and close a communication session with another 
computer. 

o If you're familiar with communications software, and you want step-by-step 
instructions for most of the tasks you'll do with MacTerminal, turn to 
Chapter 2, "Using MacTerminal." 

o If you want detailed descriptions of each MacTerminal command, turn to 
Chapter 3, "MacTerminal Reference." 

o If you want information about the way the Macintosh keyboard works with 
MacTerminal, turn to Appendix A, "Keyboard Layouts ." 

o If you are going to be communicating with an IBM® mainframe, turn to 
Appendix C, "Installing the AppleLine," or Appendix D, "Installing the 
Apple Cluster Controller." 

o For definitions of key terms, please see the Glossary. 
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What MacTerminal 
Does 

• The Terminal 

• TheOther 
Computer 

With MacTerminal , your Macintosh can communicate with 

o another Macintosh using MacTerminal 

o a Macintosh XL using MacTerminal with MacWorks XL 

o any personal computer with appropriate communications software 

o an IBM or other mainframe computer 

A computer terminal's basic job is to send information to and receive 
information from another computer. A terminal has a keyboard you use to enter 
information and a display screen to show what you 're receiving and sending. 

MacTerminal is an application that gives your Macintosh the characteristics of a 
terminal while your Macintosh retains its power as a computer. With Macintosh 
as a terminal, you can exchange information with other Macintoshes or other 
personal computers, as well as gain access to the data bases, applications, and 
storage capacity of large computers. 

MacTerminal is technically called a terminal emulator because it can emulate 
(or imitate) any of three popular computer terminals- a DEeM VT100TM, 
a TTY (Teletype) , or an IBM 3278. 

The computer you want to communicate with must have its own 
communications software. Each personal computer must have a terminal 
emulator. A larger computer-for instance, a mainframe-usually has 
sophisticated data communications software to manage the flow of 
information between it and many terminals. Larger systems like this are 
called host computers. 

For two computers to communicate, they must "speak the same language" 
at the same speed. MacTerminal has settings that allow you to match the 
settings of the other computer so that both computers can talk to each other. 
For example, when you subscribe to Dow Jones News/ Retrieval , you receive 
a manual that describes how to set up your terminal emulator to communicate 
with the Dow Jones News/ Retrieval computer system. These settings are 
called communications parameters. 

What MacTerminal Does 3 
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• The Connection To communicate with another computer, the Macintosh must connect to it, 
either directly by special cable or indirectly through transmission channels 
such as telephone lines. If you connect to the other computer by telephone, 
you'll attach your Macintosh to a device called a modem. The modem sends 
data from MacTerminal over telephone lines to a modem at the other end, 
which in turn sends the data on to the other computer. 

When your Macintosh is directly attached to an IBM or IBM -compatible 
mainframe and you want your Macintosh to emulate an IBM 3278 terminal, 
the Apple Cluster Controller or the AppleLine acts as an intermediary. 

When MacTerminal makes contact with another computer, you 're starting a 
communications session. The session lasts until you terminate the connection. 
The elapsed time between contact and termination is called connect time and 
is usually what you 're billed for when you 're communicating with a larger 
system. ~ 

Macintosh ---------~------------------~ II[ ] 1. 

Another personal computer --+--1 -

I g 
c:::::J • .. • . •••.• .. • . 

Mainframe computer ----!----------i c:::::J : ::: : ' " . 

Macintosh 

Apple Personal Modem -
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The Equipment 
You Need 

• About Modems 

• About Direct 
Connection 

You need the following equipment to use MacTerminal: 

o A Macintosh, Macintosh Plus, or Macintosh XL with MacWorks. 

o A modem or a direct tie line. 

o The AppleLine or Apple Cluster Controller device , if MacTerminal 
is to emulate an IBM 3278. AppleLine installation instructions are in 
Appendix C. Apple Cluster Controller installation instructions are 
in Appendix D. 

MacTerminal is deSigned to work with the Apple Personal Modem, the Apple 
Modem 1200, and the Apple Modem 300. The Apple modems are compatible 
with a few other "intelligent" modems-modems that can be commanded 
from the keyboard- like the Hayes Smartmodem 1200™ and the U.S. Robotics 
Auto Link 212NM. 

If you're using another type of modem, you 'll need special cables or adapters, 
and not all of MacTerminal 's features (such as dialing and hanging up the 
phone) may work correctly. Consult your authorized Apple dealer for help 
in choosing the correct equipment. Read the modem manual for installation 
instructions and information about special features you need to be aware of. 
If you want to read more about modems in general and the Apple modem in 
particular, turn to the section "More About Modems" in Chapter 3. 

If you're attaching your Macintosh directly to another computer, you 'll need 
special cables designed for that purpose. For example, you can purchase 
special cables for a direct Macintosh-to-Macintosh XL hookup. Consult your 
authorized Apple dealer or a data communications specialist where you'll be 
hooking up the Macintosh. 

The Equipment You Need 5 



Getting Started 

• The Flow of Work 

6 

Once you 've installed the modem or directly attached the other computer 
to your Macintosh, you're ready to use MacTerminal in a communications 
session. 

The rest of this chapter provides a general overview of what you might expect 
when you set up MacTerminal and start a session. When you actually begin 
using MacTerminal, you'll find most of the procedures you need in Chapter 2, 
"Using MacTerminal." If you should use MacTerminal in unique situations 
that aren't covered in Chapter 2, you'll find Chapter 3, "MacTerminal 
Reference," a good source of information about the capability of each 
command in the application. 

The following pages take you through a typical series of steps for setting up a 
communications session for the first time using a new MacTerminal document. 
Here 's a summary. 

1. Start MacTerminal and open a new MacTerminal document. 

2. Change the document's settings to match those of the other computer. 
(If you use one of the specialized documents provided on the MacTerminal 
disk, most of this step is taken care of for you.) 

3. Save the document's settings. 

4. Make contact with the other computer. 

5. If you're communicating to a host computer, complete a sequence of steps, 
called logging on, for identifying yourself (and sometimes your Macintosh) 
to the other computer. 

6. Send files to the other computer, or draw information from it. 

7. Terminate the communications session. 

Chapter 1 : About MacTerminal 
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• What'sa 
MacTerminal 
Document? 

A MacTerminal document is like the document of any other Macintosh 
application-you can open it, move it and resize it, name it, and save it on a 
disk. But a MacTerminal document differs in a significant way. The document 
lets you set up communication with another computer, and provides a display 
area in which you see and work with incoming or outgoing data. 

If you'd like, you may start your MacTerminal disk, open a new document, 
and take a look at the contents of the window. Here's how. 

Note: If you have a hard disk connected to your Macintosh, see "Using 
Mac Terminal With a Hard Disk, " in Chapter 3, before opening a new 
Mac Terminal document. 

1. Be sure the Macintosh keyboard and mouse are firmly attached, and then 
turn on the Macintosh. 

2. Insert the disk into the disk drive . The MacTerminal disk icon, named 
Terminal, appears on the desktop. It's highlighted to show that it's selected 
and ready for the next action. 

3. Choose Open from the File menu (or double-click the icon) to open the 
Terminal disk icon. In the MacTerminal window, you see the MacTerminal 
application as well as the sample documents and the System Folder. 

Macintosh Commeorcia 1 Se-rvices 

System Folder Apple Cluster Contro ner AppleLine 

~ 
Hard Disk Documeont AppleLine Supervisor 

Getting Started 
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4. Click MacTerminal and choose Open from the File menu (or double· click 
MacTerminal) to open a new MacTerminal document. If you have a hard 
disk other than Apple 's HD20, and if you have a modem connected to the 
Printer port on the back of your Macintosh, then open the Hard Disk 
document. 

Your communications session with another computer takes place in the 
tenninal display area. The menu bar contains the commands to set up the 
terminal and start a session. The cursor indicates the position where incoming 
or outgoing data appear in the terminal display area. You can use the scroll bars 
to see data that's scrolled off the top (above the dotted line) or off the right side 
of the terminal display area. 

Because a MacTerminal document is a "terminal" screen, some of the editing 
features you 're used to in other applications aren't available in a MacTerminal 
document. You can use only Copy and Paste; Cut and Undo work only in desk 
accessories. There's no insertion point that you click to position; instead, the 
cursor moves along as the characters appear on the screen. Backspace alone 
mayor may not delete characters dependin on the wa ou set it up. 

After you set up the MacTerminal document to match the communications 
parameters of the other computer, you save the document with its settings and 
use it each time you want to connect to the computer you created it for. 

Chapter 1: About MacTenninal 



Setting Upa 
MacTerminal 
Document 

Once you've opened a MacTerminal document, you use the commands in the 
Commands, Settings, and Phone menus to set up a communications session. 
Suppose you want to send a MacWrite document to a friend who has an 
Apple lie or to your company's mainframe computer. You'll need to know the 
communications parameters for these computers and set MacTerminal up 
accordingly. If you can't find out what the parameters are, use the preset ones 
for a new document and see what happens when you start a session. Then turn 
to "Troubleshooting" in Chapter 3 and try the possible solutions to whatever 
problem you encounter. 

The Commercial Services document on the disk is already set up to 
communicate with information services such as THE SOURCE, CompuServe, 
and Dow Jones News/ Retrieval. All you need to do is enter the service's 
telephone number, called the access number, and perhaps change the speed 
at which you're sending and receiving information (the baud rate). 

The Macintosh document is preset to communicate with another MaCintosh, 
Macintosh Plus, or Macintosh XL using MacTerminal 1.1. The document is set 
up for a modem connection. You 'll change that if your Macintosh is directly 
connected. With a modem, all you do is enter the access number and dial. 

The Hard Disk document helps you avoid potential problems using 
MacTerminal with hard disk drives other than Apple's HD20. Read "Using 
MacTerminal With a Hard Disk," in Chapter 3, before you use MacTerminal 
if you have another hard disk drive. 

If you're using MacTerminal to emulate an IBM 3278, you'll use the AppleLine 
and AppleLine Supervisor documents, or the Apple Cluster Controller 
documents. Refer to Appendix C for information about AppleLine and 
Appendix 0 for information about the Cluster Controller. 

Setting Up a MacTenninal Document 9 



• Setting Up 
Compatibility 

You can start setting up MacTerminal with any of the commands in the Settings 
menu , but you may want to start with the Compatibility settings because 
that's where you set most of the communications parameters. You choose 
Compatibility from the Settings menu and change the options by clicking the 
option title, or the circle or square, and then confirm the settings by clicking the 
OK button (or cancel your choices by clicking the Cancel button). 

Compiltibility Settings 

ilud Rilte 0 50 0 75 OliO 0134.5 

0 150 0200 0 300 0600 

@ 1200 01800 02000 02400 

These options specify how - ....... --1 
03600 04800 09600 019200 

your data is transmitted its per Chilrilcter 0 7 Bits @8 Bits 

and received ilrity 0 Ellen 0 Odd @None 

ilndshillce 0 HOn / HOff @ None 

onnection @ Modem o Another Computer 

These options let -----"'+---1 
onnection Port @ I~I 0 I~I MacTerminal know what's 

attachea to the Macintosh 
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You don't need to know what each option means to set up your document, 
but if you're curious, refer to Chapter 3, "MacTe[minal Reference," for a 
description of each option. 

Unfortunately, not all data communications manuals refer to the compatibility 
options in exactly the same way. Baud [ate is a standard expression, but you'll 
also see bps (bits per second) for baud [ate. Bits per character is sometimes 
referred to as a 7 ·bit or 8·bit word. For Handshake, you may see enable 
x On/XO!f 

Some manuals refer to two parameters called full duplex or half duplex. These 
terms describe how a signal is sent along the transmission lines. Duplex means 
two·way. Full duplex means you can both send and receive, at the same time. 
Half duplex means you can do only one at a time-either send or receive. 

Chapter 1: About MacTerminal 
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• SettingUp 
Terminal Features 

MacTerI!lin.?1 is preset for full duplex, so you don't need to change anything 
if the other computer requires that setting. If the other computer specifies half 
duplex, you' 11 cl1eck the option Local Echo in ti1e 'lerml11al settings dialog box, 
described in the next section. 

If you're communicating with a modem, your choice of baud rate is limited by 
the slowest modem on either end. If yours is a 300-baud modem and the other 
modem has a 1200-baud capacity, you have to use 300 for the baud rate setting. 
Directly connected computers can communicate at much higher baud rates; 
if you're connected to a VAX computer for example, you can use 9600 baud . 

You choose the Terminal command to set the terminal type that MacTerminal 
will emulate and to set some of its special features. The preset options for a new 
document reflect a typical setup for communications with most larger systems, 
including the same commercial information services the Compatibility options 
are set for. You probably won't need to change any of the options unless you're 
communicating with another personal computer or working with data (such as 
charts or tables) wider than 80 columns. 

" File Edit Commands !~Phone Keypad 

Untitled 

Terminal Settings 

Choose among a DEC --~f-+---~Terminal @ UTI 00 TTY 0 IBM 3278 

VT100 , a TTY, or an IBM - - Mode • ANSI 0 UT52 

Set your preferences for these ~I---+~ Cursor Shape @ Underline 0 Block 

line Width @ 80 Columns 0 132 Columns 
For IBM 3278 terminal only -++--*, 

Protocol Conu 0 flpploU np 0 Cl\l~tp( r Ur 
Check this to display the ---+-+---1+------------_ 
VT100 status lights ,.... [EI On line ,/-J local Echo Status lights 

,.... [EI Auto Aepeat I/-J Auto Wraparound New line 
Check these if the remote--H---+------..&..-------/ ) 

I ~ Repeat ctrls Q Tronspdlon1 ~ ~ 
computer doesn't proVide v- " ~~) 10 ''J 

the feature - most do b=)iTq--tl~'-======~===========dJ------,Ir?'frQI2:J'i:;j 

I 
Check this to have a 
control character like 
Return repeat when you 
hold it down 

I 
Check this to see 
nonprinting characters 
(TTY only) 
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The DEC VTl 00 is preset as the most likely choice for terminal type. It's a more 
sophisticateCffeTminal than the TTY, and many larger systems can work with 
its special features. Remember, when you 're communicating with a large 
computer, the terminal simply provides access to that computer's data bases, 
applications, and storage capacity. A more sophisticated terminal like the DEC 
VTl 00 lets you use more sophisticated programs on the other computer-
for example, a full-screen word processing application. 

If a remote computer can't take advantage of a DEC VTl 00, choose TTY-a 
simple teletype-like terminal that understands a carriage return but n3t much 
e1se. If you 're communicating with an IBM mainframe, choose IBM 3278. 

When you change the terminal type, other options remain bold or dim 
depending on whether or not they work with the terminal type you've selected. 

If you're communicating with another personal computer, you 'll probably 
check the Auto Wraparound and New Line options. Most large modern 
computer systems provide these two features, but you can set MacTerminal 
to provide them if the other computer doesn't. YQu check Local Echo if you /e 
communicatin with another ersonal com uter, or whenever the other 
computer specifies half duplex. Leave it unchec e i t e ot er sys em 
spc:cifies full duplex. -

Sometimes it's easier to know how to check the Terminal options by seeing 
how incoming data appears on the screen when your communications session 
gets started. Then, if you see problems, refer to ''Troubleshooting,' ' in 
Chapter 3, to correct them. 

If you want to know more about any of these options, refer to the option under 
"Terminal," in the section "Settings Menu" in Chapter 3. 

Chapter 1: About MacTemlinal 
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• Preparing to 
Transmit a File 

You can send any Macintosh file to another Macintosh, Macintosh Plus, or 
Macintosh XL. The term file refers to any amount of information stored as a unit 
on the disk- for example, a document or a system file. 

If the other computer can't work with Macintosh documents, you can send.tex!, 
files-documents you save as text, without pictures and without most format, 
font , or style information. Text files (also called ASCII files) are in a form 
almost all computers can understand. Many Macintosh applications give you 
the choice in the Save As command in the File menu of saving the document as 
it is or as a text file. For instance, in MacWrite, the Text Only button allows you 
to save a text file. In Multiplan®, the SYLK button does so. 

Some applications automatically change a document to a text file when you 
save it. You 'll never notice the difference when you work in the document, but 
you can send the file without saving it specifically as a text file. Refer to the 
application's manual for information about sending its documents to another 
computer. 

The options in the File Transfer command let MacTerminal know what kind of 
transfer method you 're using and what kind of software is at the other end. 

Settings for Pasting or Sending TeHt: File Transfer Protocol 

Delay Between Chars ~ 60ths Second @ TeHt 

Delay Between Lines ~ 60ths Second 0 MacBinary 

121 Word Wrap OutgOing TeHt 0 HModem TeHt 

o MacTerminal 1.1 

Settings for saving lines off top: 

121 Retain Line Brealcs 

o Save Screens Before Clearing 

Setting Up a MacTerminal Document 
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The settings for pasting or sending text govern its speed and arrangement. 
Once you set the same baud rate on both computers, using the Compatibility 
Settings, the computers can usually keep up with each other. On rare 
occasions, you may need to go farther. For instance, if you jump your cursor 
from the top left to the bottom right of the screen, and click, a receiving 
computer may not be able to keep up with the rush of data about the cursor's 
position. Data gets lost. If this happens to you, then- very gently-try 
experimenting with delays between lines, then between characters, until you 
find a setting that works. 

In some situations, you may want to make your text easier for someone else to 
read at the other computer, by breaking lines after a word rather than in the 
middle of one; if so, cpeck Word Wrap. 

If you're receiving and saving information, and have already chosen the 
Command menu option to Record Lines Off Top, you may want to have 
MacTerminal save the Return characterssent at the end of each line- or 
eliminate them. For instance, if you plan to copy this text into MacWrite, which 
interprets every Return character as the end of a paragraph, you'll want to get 
rid of the Returns at the end of every line. How? Uncheck Retain Line Breaks. 

If you intend to save your entire communications session, and you are 
receiving whole screens of information at a time from a mainframe, be sure 
you've already selected Record Lines Off Top, on the Commands menu; 
then check Save Screens Before Clearing in the File Transfer Settings. Some 
applications clear the screen frequently, without scrolling the lines off the 
top-so, without this command, your information would be lost. This way, 
in a few minutes, you may accumulate lots of data on your disk. 

If you get a message that your disk is full , and you still want to record lines or 
save screens, choose Save As on the File menu, and use Eject and Drive to shift 
toa new disk with more room. When you've saved your file, turn Record Lines 
Off Top back on, and choose Save Screens Before Clearing again. 

The File Transfer protocol refers to the conventions used to send or receive a 
file. Essentially, a protocol is an agreement between two computers about how 
they'll exchange data. 

Chapter 1: About MacTerminal 



o The Text transfer method sends or receives files that contain only text, 
a sequence of ASCII characters without any information about format or 
font. Text is a fairly reliable way to exchange information between 
computers, but if there 's an error in transmission, it won't be corrected or 
pointed out. When emulating an IBM 3278 talking to a mainframe, use Text. 

o The MacBinary transfer method can transfer any Macintosh file 
(a document, an application, or a system file) to or from any computer that 
supports a protocol called XModem. The XModem protocol, originally 
developed by Ward Christensen, is an agreement to send data and keep on 
sending data until it gets there; it also checks errors, to make sure your file 
arrives intact. You can use MacBinary to transfer files from a Macintosh to an 
information service such as CompuServeTM

, and, if you want, from there to 
another Macintosh. Before you receive a file this way, you must use the 
Receive File option in the File menu. 

o The XModem Text method works with computers that use the XModem 
protocol, but do not understand the formatting information in a Macintosh 
file . Unlike mere Text transfer, this method checks for errors. It also keeps 
your formatting intact, by sending a line feed signal after each Return. 
(The line feed tells the other computer to move down to the next line before 
starting the next line of text.) When you are receiving text, XModem Text 
strips those line feeds out. To receive a file by using this protocol, be sure to 
select Receive File on the File menu . 

o The MacTerminall.l transfer method allows you to transfer any type of file 
between two Macintoshes running MacTerminal. The Macintosh document 
that comes with your MacTerminal disk is already set to this option. 

o The Straight XModem method is only for programmers. If you're not sure of 
what you're doing, avoid using this method. This method transfers the data 
portion of a Macintosh file, along with format, fonts, sizes, styles, graphic art, 
and page breaks, to another computer that supports the XModem protocol. 
To receive such a file, select Receive File on the File menu. 

Setting Up a MacTerminal Document 15 



• Entering the 
Access Number 
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If you 're using a modem to communicate with the other computer, you choose 
Phone Settings from the Phone menu and enter the other computer's access 
(telephone) number to set up MacTerminal to call the other computer. 

Phone Settings 

Phone Number 

19,8005551212 

Dial @Tone o Pulse o Milled 

Number of Rings Before Rnswer D 
Modem 0 Apple 300 @ Apple 1200 0 Other 

o [cancel] 

The other options in this dialog box let you specify the type of phone system 
in your area, the number of times you want your phone to ring before your 
modem answers it (used for receiving a call from another computer), and the 
speed of the Apple modem you 're using. As with other dialog boxes, you 'll find 
detailed information about each option in Chapter 3, "MacTerminal 
Reference.' , 
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• Saving the 
Settings in a 
MacTerminal 
Document 

Once you 've set up a MacTerminal document so you can communicate with 
a particular computer, you may want to save the settings by choosing Save As 
from the File menu. Give the document the name of the computer service or 
person you set it up for. Macintosh stores the document on the disk, and a 
document icon appears in the Finder. Each time you want to connect to that 
computer-to call the Dow]ones News/ Retrieval service, for example, to find 
out how your stock is doing-you'll be able to open the document with the 
proper settings and access number. 

You may find it convenient to start the session this way. Then, before actually 
dialing or making connection, save the document under a new name, 
indicating its date or contents. That way your original document with the 
settings and access number will always come up uncluttered, ready to use 
again. 

~Edit Commands Settings Phone Keypad 

Untitled 
. .. .... , ...... 

~ -

Saue as: Terminal 
I THE SOURCE I [ Eject 1 
[ saue~ [ Cancel 1 [ Oriue 1 

{} 
;)1 10 I2J 
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Making the 
Connection 

• Receiving a Call 
From Another 
Personal 
Computer 

• LoggingOn 
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Once you 've set up the MacTerminal document, you 're ready to connect to the 
other computer and start a communications session. If your Macintosh is 
directly connected to the other computer and is set to communicate with it, 
you can start sending and receiving information at any time. If you 're using a 
modem, you start a session by turning on the modem and choosing Dial on the 
Phone menu. 

If the Apple modem's volume is up enough, you hear connection noises as the 
modem is dialing and a brief high-pitched sound when the computer answers. 
MacTerminal tells you whether it's made a connection or not. If it doesn 't make 
a connection the first time, always try again. If the problem persists, turn to 
"Troubleshooting" in Chapter 3 and try the solutions presented there. 

When you 're expecting to receive a call from another computer, you make sure 
your Settings match those of the other computer, turn the modem on, use 
Phone Settings in the Phone menu to specify the number of times you want the 
phone to ring before the modem answers, and then choose Wait for Call in the 
Phone menu . If you 're using the MacBinary, XModem Text, or Straight 
XModem protocols, choose Receive File on the File Menu. When the call 
comes in , the modem answers the phone, and MacTerminal confirms the 
connection. Usually, you 'll type something (or send a standard Answerback 
Message, discussed in Chapter 3) to let the other person know you 're there and 
to indicate that you 're ready to send a file or to receive one. 

If you 'd like to know more about your telephone 'S relationship with your 
modem, read "More About Modems" in Chapter 3 . 

Once MacTerminal is connected, your next steps depend on whether you 're 
connected to a host computer or to another computer that's communicating 
only with you (probably another personal computer) . 

When you connect to another personal computer, you and the person at the ~ 
other end can begin communicating by typing on the keyboard or by sending 
files. When you connect to a host computer, you have to complete a series of ~ 
steps defined by the host computer to identify yourself -a procedure called 
logging on- before you can read data, work in an application, or send and ~ 
receive files . 
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Most host computers ask you for your name (or account number) and the 
password you received when you opened an account with the system. Some 
ask you to identify your terminal. The queries are usually in the form of a 
prompt-an abbreviated question. All the proper responses should be in 
the host computer's user's manual. Except for the password, you see your 
responses on the screen. The other computer usually doesn't echo back the 
password; that's to protect your account from pirates or other unsavory, 
unauthorized users. 

Log-on procedures are usually very precise. If you type a space where one's not 
indicated or use a lowercase letter when uppercase is called for, the host 
computer probably won't accept your entry. Instead, the host computer sends 
you a more-or-less polite message telling you to try again or get help. 

" File Edit Commands Settings Phone Keypad 

D MCI 

Por t: 7 . 

P I ease enter'" your user name : ej honson 
Password : 
Sor'ry, i ncot-'rec: t 5 i gnon in forma t i on . 
p I ease try ago in . 

p I ease en ter your uset ... name : ej ohnson 
Passluord : 
Connect i on in it i ated . Opened . 
We I c ome to Me I Mo i I I 

Post ONITE on weekends ti I I Midnight 
Sunday for ~londay morn i ng de I i very in 
15 ci ties Type HELP ON I TE . 

Thursday ~ 5 head lines at 4 pm EDT 

M; king tI r Connl ct' JI 

.. :hi: 
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• The Macintosh 
Keyboard 

Some log-on sequences may ask you to use a key like Control, Escape, or Break. 
When you're using MacTerminal, these keys on the Macintosh keyboard act as 
special keys: 

0 
MacP\us 

20 

[ ;}€ ~ qJhe Command ke)::, located to the left of the space bar, becomes the 
Control key. o D The key located on the top left of the keyboard becomes the ~cape k.fy. You 
can still get the grave accent ( - ) by pressing the Command key along with 
this one; you can get the tilde (-) by pressing the Command and Shift keys 
along with this one. 

U 
Mac 

1 

[B~kspace J 

D The Enter key, located to the right of the space bar on a Macintosh, or to the 
right of the numeric keypad on a Macintosh Plus, becomes t~ Brea~~y for 
a DEC VT100 terminal type. When you 're using MacTerminaras a DEC 
VT1 00, use the Return key when the other computer asks you to press Enter. 
When you 're using MacTerminal as an IBM 3278, the Enter key remains an 

--enter key and doesn't change its function. 

D The Backspace key backs your cursor up one character. By using the 
Keyboard command on the Settings menu, you can determine whether it 
just backs up, or deletes the character it passes over. 

See Appendix A for a layout of Macintosh and Macintosh Plus keyboards when 
you 're using MacTerminal. 

- DU use the Control key by holding it down while ressin some other ke . For 
example, if a service reg~u to use Control-C to log off, hold down the 

-fontrol (Command) key and press the letter C. You use the Escape key by 
pressing the key and then pressing some other key. For instance, Escape-l 
means to press Escape, release it, and then press 1. 
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A Communications 
Session 

• Saving Data for 
Later Use 

You can start sending and receiving files immediately when you 're 
communicating with another personal computer. With a host computer, 
however, it's a little more complicated. 

When you've successfully logged on, most host computers welcome you in 
some way and present you with the main menu of options available on the 
system. When you choose one by typing its number or command, you often get 
another menu of choices within that main topic. This is a very common way for 
large complex programs to guide you through available data bases, 
applications, and communications networks. 

You may look up some statistics, arrange an airline flight, check the facts on 
a new invention, leave a message for a friend. You may sign on to another 
computer, and use its specialized program for a few minutes, arranging a 
manufacturing process. You may participate in a conference, respond to 
questions posted on an electronic bulletin board, or buy stock. 

Sometimes a communications session can get muddled up, through no fault 
of your own. There are a lot of possibilities for problems when two different 
computers are trying to communicate over a long distance. If you should start 
to receive what looks like hieroglyphics instead of text, and you don't know 
why, and nothing you do seems to make a difference, you can use the Reset 
command from the Commands menu to chuck it all and stan over. Reset erases 
everything in the terminal display area and puts the settings back to the way 
they were when you last saved the document. 

As soon as you start to receive information from the other computer, 
MacTerminal is preset to record the data for later use. The Record Lines Off Top 
command from the Commands menu (when it's chosen, it changes to Don't 
Record Lines Off Top) tells MacTerminal to save data in the document as the 
data scrolls off the top of the terminal display area. MacTerminal activates the 
appropriate scroll bar as soon as there 's data recorded off the top of the screen. 

If you 've already named the document and saved the settings, MacTerminal 
also saves the data to the document on the disk. If you haven't saved the 
settings, MacTerminal stores the data in a temporary place until you do save 
them, or throws the data away if you don't. 
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The Don't Record Lines Off Top command tells MacTerminal to throw 
away lines of data as they scroll off the top of the terminal display area. If 
MacTerminal has recorded data and you decide you don't want the data, you 
can use the Clear Lines Off Top command from the Commands menu to tell 
MacTerminal to erase everything it has recorded above the dotted line. 

Some mainframe applications send you a screen full of information and then, 
without scrolling up, erase it and replace it with the next screen. To capture this 
information, select the command Record Lines Off Top, and then select File 
Transfer on the Settings menu and check Save Screens Before Clearing. 

You can select any data in the terminal display area or recorded above the 
dotted line . You can copy a selection into the Clipboard and paste it into a 
document from another application, into a desk accessory such as the Note Pad 
(if it fits on one Note Pad page), or even back into MacTerminal. Or you can 
print the selection. Pastin any selection into MacTerminal durin a 
communications s Ion sen s t e ata to the oth~ 
-----------

Some applications accept the contents of a MacTerminal document directly 
without your haVing to select and copy the data. Once you save the document 
and quit MacTerminal, you move the document to the disk that has the 
application you want to use with that document. Select both the MacTerminal 
document icon and the application icon (click one icon, hold down the Shift 
key, and click the other). Choose Open from the File menu. A new document 
for the application opens with the data from the MacTerminal document in its 
window. 

When you receive a file by using the Text protocol, you see the text appear on 
your screen. When you receive a file by using any other protocol, you do not see 
the text on your screen; instead, you see a gauge indicating how much of the file 
has been transferred from the other computer to your disk. 

Once you have received a file from another Macintosh by using any protocol 
except Text, you can see the contents of the file this way: you start by quitting 
MacTerminal. You will see the icon or name for your new file in the Finder. You 
can now open this file if you have the appropriate application on the disk. 
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When you 've received a file from any other computer by using any protocol 
other than Text, and you want to open the file , quit MacTerminal. In the Finder, 
you 'll see a "blank page" icon. Click the icon, hold down the Shift key and click 
MacWrite. Then choose Open from the File menu. 

When you have received and saved a text file, you can open it this way: Launch 
the application (such as MacWrite). Close the Untitled document, then select 
Open on the File menu. The document should appear on the list. Select it. Your 
application may then need to convert the pure text file into a file of its own 
kind; if so, you 'll be asked whether you want Returns to indicate line breaks 
or paragraphs. To save the format, choose Paragraphs. 

You also need to consider the Retain Line Breaks option in the File Transfer 
command (Settings menu) when you're saving incoming data. This option lets 
you decide whether MacTerminal should save or delete the Return character 
that most remote computers send at the end of a line. You 'll choose to save or 
delete the Return character depending on how the application to which you're 
copying uses it. 

For example, in MacWrite a Return character marks the end of a paragraph; 
you don't use Return at the end of lines within a paragraph. If you copy text to 
MacWrite from MacTerminal, and the text has a Return character at the end of 
each line, MacWritewill treat each line as a separate paragraph. So when you 're 
copying data from MacTerminal to MacWrite you uncheck Retain Line Breaks . 
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• Sending Data to 
Another Computer 

• Using Another 
Computer's 
Applications 

24 

When you're in a communications session, you can use the Send File 
command in the File menu to send files from your Macintosh to any other 
computer with the appropriate communications software. 

If you've set the File Transfer protocol to MacBinary, MacTerminall .l , or 
Straight XModem, the Send File command presents a list of all Macintosh files, 
including documents, text files, applications, and system files. If you set up 
MacTerminal to send text files to most other computers (Text or XModem 
Text) , you'll see a list of text files only. You can send a file by double-clickin 
the file name, or by choosing the file name an t en clic ing t e Sen utton. 

During a communications session, the Paste command sends to the other ~ 
computer whatever text you've previously cut or copied into the Clipboard, just 
as if you'd typed the text on the keyboard. You can compose a short note on the !! 
Note Pad desk accessory, cut or copy the note to the Clipboard, prepare the 
other computer to receive a file, choose Paste, and off it goes. See "Sending !! 
a Small Amount of Text" in Chapter 2 for more information. 

In addition to data bases, bulletin board services, and communications 
networks, many large systems have applications for you to use-a word 
processing or spreadsheet application, budget forecaster, and so on. If you 
choose to work in one of these applications, you'll quickly see the advantage 
of the DEC VT100 terminal type. Unlike the TTY terminal, the DEC VT100 
terminal lets you do things like highlight text or scroll anywhere in the terminal 
display area. 

Some host computers have applications that use a full screen of data at a time. 
Text editors are the most common full-screen applications. If you're using one, 
read ' 'Using a Full-Screen Application," in Chapter 3, for more specific 
information. 
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• Terminating a 
Session 

If you 've been communicating with a host computer, always terminate a 
communications session by typing the remote computer's log-off command. 
Then, if you're usin the A Ie modem choose Han 0 from the Phone 
menu . any host computers terminate the connection after a few minutes if 
there's no activity on your end. (If you're deep in thought, type any character 
just to let the remote computer know you 're there .) So~mputers d~' t 
terminate a connection until the receive a 10 -off command from you. You 
may ave turned off the Macintosh and the modem and gone to e , ut the 
other computer doesn't know that and is charging you for connect time as you 
doze off. 
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Introduction This chapter provides step-by-step instructions for most of the things you 'll do 
with MacTerminal. You don't have to read the chapter in any particular order; 
each topic is independent of the others or includes cross-references where 
needed. 

The commands in the menus mentioned in this chapter are explained in detail 
in Chapter 3, "MacTerminal Reference. " 
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Setting Up a New MacTerminal Document 

A new MacTerminal document is preset to communicate with 
most popular commercial information services. Each preset 
option is marked in its circle or box. With any document, you can 
use the preset options or modify them. To change a setting from 
one option to another, click the option name, the circle, or the 
square. Some features have only on and off options: click an 
unchecked feature to turn it on; click a checked feature to turn it 
off. To confirm the settings in a dialog box, click the OK button 
(or, to cancel, click the Cancel button). 

The MacTerminal application disk comes with six documents 
already set up for you- Macintosh, Commercial Services, Hard 
Disk, AppleLine, AppleLine Supervisor, and Apple Cluster 
Controller. 

The Macintosh document is preset so that you can communicate 
with another Macintosh or a Macintosh XL using MacTerminaI1.1. 
(See "Communicating With Another Macintosh" later in this 
chapter.) The Commercial Services document is preset to 
communicate with most public information services and is set up 
as a new MacTerminal document. Some information services 
may require slightly different settings-for instance, MCI Mail 
requires that you turn on Handshake (Settings menu: 
Compatibility). If you 're communicating with an IBM 
mainframe, use the AppleLine or the Apple Cluster Controller 
documents to communicate through these intermediary 
devices. (See Appendix C, "Installing the AppleLine," and 
Appendix D, "Installing the Apple Cluster Controller. ") 

If you are using a hard disk other than the Apple Hard Disk 20, 
and if your hard disk is connected to the Modem port, use the 
Hard Disk document. For more information, see "Using 
MacTerminal With a Hard Disk," in Chapter 3. 

1. Open a new 
MacTerminal 
document. 

Select MacTerminal and 
choose Open from the File 
menu (or double-click 
MacTerminal) . 

The application presents you 
with a new document called 
"Untitled. " 
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2. Set the Terminal and 
Compatibility options 
in the Settings menu. 

To set the Terminal options, 
follow these steps: 

• Set the Terminal type. 

• You can leave the 
remaining options as they are 
for most host computers. 

• For another personal 
computer, you may need to 
check Auto Wraparound, 
Local Echo, and New Line­
features that most larger 
systems would provide. See 
"Communicating With 
Another Personal Computer" 
later in this chapter. 

To set the Compatibility 
options, follow these steps: 

• Set the options for Baud 
Rate, Bits per Character, and 
Parity to match the other 
computer's settings. 

• If the other computer uses 
a Handshake protocol, and 
if you're transmitting data 
at speeds over 1200 baud, 
check X On/ X Off. 

• Set Connection to Another 
Computer if you're 
communicating by direct 
cable rather than a modem. 

• The Modem Port option is 
preset and the only option 
recommended for use with 
either a modem or a direct 
connection. Ifyciu have a 
hard disk, see "Using 
MacTerminal With a Hard 
Disk" in Chapter 3. 



3. Decide whether you 
want to save incoming 
data. 

If you don 't, select Don't 
Record Lines Off Top on the 
Commands menu. 

If you do want to save the 
information, select Record 
Lines Off Top. If you are 
receiving data from a 
mainframe that sends one 
screen after another, clearing 
them without scrolling off the 
top, select File Transfer on 
the Settings menu, and check 
Save Screens Before 
Clearing. 

4. If you want to send 
a file, choose the File 
Transfer command 
from the Settings 
menu. 

• Choose a protocol. 

• If you want to end lines 
between words, choose 
Word Wrap Outgoing Text. 

For details on these settings, 
see "Setting Up to Transmit a 
File" in Chapter 1, and" File 
Transfer Settings," under 
"Settings Menu," in 
Chapter 3. 

S.lfyou're 
communicating by 
modem, choose the 
Phone Settings 
command from 
the Phone menu. 

• Type the phone number 
(called the access number) 
of the other computer, 
including a number to get an 
outside line and the area code 
if needed. Type a comma 
after the number for an 
outside line. Example: 
9,(415)5551212. 

You can type parentheses and 
spaces if it makes it easier for 
you to read the number. 
The Apple modem ignores 
everything except numbers 
and commas. 

• Set Dial by checking Tone, 
Pulse, or Mixed, depending 
on the telephone system in 
your area. See the "Phone 
Menu" section in Chapter 3 
for more information. 

• If you're expecting a call 
from another computer, 
specify a number between 
1 and 255 for the Number of 
Rings Before Answer option. 
This option tells the modem 
the number of times you want 
the phone to ring before the 
modem answers it. A setting 
of 0 tells the modem not to 
answer the phone at all. 

• Check the Modem option 
to match the modem you're 
using. Be sure you've 
checked Modem in the 
Compatibility dialog box 
in the Settings menu. 

Setting Up a New MacTerminal Document 

6. Save the settings 
before starting a 
communications 
session. 

Choose Save As from the File 
menu, name the document, 
and then click the Save 
button. 

See "Saving a Document" 
later in this chapter for further 
instructions. 
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Starting a Communications Session 

If you 're using a modem, you start a communications session by 
using the Dial command in the Phone menu to dial the other 
computer's phone number (called the access number). 
Once connected, if the other computer is a host computer, you 
log on to get "into the system." If you 're involved in one-to-one 
communication with another personal computer, you can 
immediately start typing to each other, or sending and receiving 
files . 

1. Open a MacTerminal 
document and set it to 
communicate with the 
other computer. 

If you're communicating by 
modem, be sure you 've 
specified the Connection 
and Connection Port in the 
Compatibility dialog box and 
that you 've typed the phone 
numher and specified proper 
settings in the Phone Settings 
dialog box (Phone menu). 

If your Macintosh is directly 
connected to the other 
computer, go to the last 
paragraph of step 4 of these 
instructions. 

See "Setting Up a New 
MacTerminal Document" 
earlier in this chapter. 
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2. Choose DiaUi'om the 
Phone menu if you're 
originating a call 
through an Apple 
modem. 

MacTerminal informs you 
that the Apple modem is 
dialing the number you 
entered and whether or not 
the call is answered. With the 
Apple modem's volume up 
enough, you can hear the 
dialing sounds and a brief 
high -pitched tone when the 
computer answers. 

If you don 't make a 
connection the first time, 
try again. If you still don 't 
connect, check that the baud 
rate is correct (Settings 
menu Compatibility). 
Also see "Troubleshooting" 
in Chapter 3. 
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3. If you're receiving a 
call through an Apple 
modem, choose Wait 
For Call. 

If you are using the 
MacBinary, XModem, 
or Straight XModem File 
Transfer protocols, select 
Receive Files on the File 
menu . 

The Apple modem answers 
the incoming call after the 
number of rings you've 
specified in the Phone 
Settings menu . 

@ 
4. Once connected, 
start typing to another 
personal computer, 
or log on to a host by 
responding 10 its 
prompts. 

Prompts differ from one host 
computer system to another; 
however ou'll aim 
always be asked tor a name 
or an account number ana a 
password. In addition, some' 

a 
identifier, found in the gUide 
to the system or information 
service. And if you're 
connecting to the service 
through a phone network 
like Telenet® or Tymnet®, 
you 'll be asked to identify 
which service you want. 

If a prompt is repeated, it 
usually means that you made 
a typing mistake: You typed 
a space where you shouldn't 
have, or used lowercase 
when only uppercase letters 
work, or pressed Return once 
when you were supposed 
to press it twice. The list of 
possible mistakes isn't 
endless, but it can be 
frustratingly long. Try again. 

If a log-on sequence asks you 
.~ control character liKe 

Control·C, hold down tfie -
--eum~. ----
If you 're not connecting with 
a host computer, but with one 
that's communicating only 
with you-a coworker's 
Macintosh XL, for example­
you can usually start sending 
and receiving information as 
soon as both computers have 
started their communications 
application and set the 
parameters, and one has 
called the other. 

5. Prepare the other 
computer to send or 
receive dala. 

• I f you've connected to a 
host computer, get into the 
"insert mode" or "send 
mode" in whatever 
subsystem you want-
a bulletin board, a word 
processing application, 
or a spreadsheet application, 
and so forth. 

Or 

• If you're not 
communicating with a host 
computer, but with one that'S 
communicating only with 
you , let the person on the 
other end know you're ready 
to send or receive data. 
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Sending a File 

With MacTerminal , you compose what you want to send-a 
letter, report, table of figures, and so forth-in the appropriate 
Macintosh application. MacTerminal can send or receive either 
the entire document or only the text of a document, depending 
on the type of software at the other end. See "Setting Up to 
Transmit a File" in Chapter 1 and "File Transfer Settings" 
in Chapter 3 for an explanation of file transfer methods. 

File Trilnsfer Settings 

1. Open a MacTerminal 
document. 

If necessary, set the 
appropriate Compatibility 
and Terminal options from 
the Settings menu. 

See "Setting Up a New 
MacTerminal Document" 
earlier in this chapter. 

Settings for Pilsting or Sending TeHt: File Trilnsfer Protocol 
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DelilY Between Chilrs ~ 60ths Second @ TeHt 

Delily Between lines ~ 60ths Second 0 MilcBinilry 

IZI Word Wrilp Outgoing TeHt 0 HModem TeHt 

o MilcTerminill 1.1 

Settings for siluing lines off top: o Strilight HModem 

IZI Retilin line Breilks 

o Silue Screens Before Cleilring 
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2. Choose File Transfer 
from the Settings 
menu. 

• If you are sending a 
Macintosh file to another 
Macintosh running 
MacTerminal , choose 
MacTerminall.1. 

• If you are sending to an 
Apple II , choose XModem 
Text. 

• If you are sending a 
complete Macintosh file to 
an information service that 
supports the XModem 
protocols, and you want 
another Macintosh to be able 
to collect the file there , 
choose Mac Binary. 

• If you are a programmer 
sending the binary version 
of the data portion of a 
Macintosh file to a computer 
that supports the XModem 
protocol, use Straight 
XModem. 

• If you are sending only the 
text to a computer that does 
not support the XModem 
protocol, use Text. 

If you are emulating the 
IBM 3278, use Text. 

• If you need to make sure 
that lines break between 
words rather than within 
them, choose Word Wrap 
Outgoing Text. 
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3. Start a 0) 
communications 
session and prepa 
the other computer 
to receive a file. 

• Open a prepared 
document. 

Or 

• Open a New document, 
choose Compatibility on the 
Settings menu , and specify 
the Connection and 
Connection Port. 

• If using the phone lines, 
choose Phone Settings on th 
Phone menu , type in the 
phone number, and specif 
the settings. Then choose 
Dial. -

For details, see "Starting a 
Communications Session" 
earlier in this chapter. 

• If you checked Text or 
XModem Text on the File 
Transfer dialog box, only text 
files (ASC II files) show up 
on a list for you to choose 
from . Select the file you want 
to send. (MacTerminal 
docu ments are text files, 
and appear on the list.) 

• If you checked any other 
protocol , you see a list of all 

. thefiles on the disk­
documents, system files, and 
so forth . ~~ct the one YQ1I 
wanttosen . 

If you have the hierarchical 
filing system that 
accompanies the Macintosh 
Plus or Hard Disk 20, you 
may need to open folders to 
find the file you want. 

If the fil e you want is on a 
different disk, click Eject and 
insert the other disk, or insert 
the disk in the external drive. 
A similar list of fi les appears 
for this disk. If you have disks 
in both drives, click the Drive 
button to switch between 
them. 

(2 . 
!J 

5. ~!!... ____ ~file ~ou 
Want to send and click 
tl1eSend button (or 
double-click the file 
name) . 

If you're sending a file with 
the MacTerminall .l , 
MacBinary, XModem Text, 
or Straight XModem 
protocol, a gauge appears in 
the window with a moving 
marker showing the progress 
of the transmission . If you're 
sending a text file, you'll 
UsuaHy-3eethe-textappearin~ 
the window-:-rfyou aon't see 

- anythmg, check Local Echo 
in the Terminal dialog box 
(Settings menu) and try 
sending again. 

To stop sending a file, hold 
down the Command key and 
press the period (.) key. 

Commands Settings Phone Keypad 

Sending a File 

Commercial Seruices 

Apple Cluster .. . 
AppleLine 
AppleLine Sup .. . 
Commercial S .. . 
Hard Disk 

Macintosh 

Send iJ Terminal 

Eject 

Cancel Driue 
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Sending a Small Amount of Text 

You can send text by cutting or copying it to the Clipboard and 
pasting it into the MacTerminal document. This is a quick way to 

• send text you've composed on the Note Pad. Type a note on the 
note page, select the text (you can select only one page at a 
time) , copy or cut it, close the Note Pad, and choose Paste . 
MacTerminal sends the text to the remote computer just as if 
you'd typed the text in the MacTerminal display. By the way, 
when writing in the Note Pad, use the regular characters; don 't 
use the foreign characters and symbols available by pressing 
Option at the same time that you press a key. MacTerminal does 
not transmit those extra characters. 

1. Select text you want 
to send and choose Cut 
or Copy from the Edit 
menu. 

The text appears in the 
Clipboard. The contents of 
the Clipboard remain until 
the next cut or copy, until you 
turn the Macintosh off, or 
until its power is interrupted 
in some other way. 
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2. Open a MacTerminal 
document. 

If necessary, set the 
appropriate Compatibility 
and Terminal options from 
the Settings menu . 

In the Terminal dialog box, 
check Auto Wraparound and 
New Line to see the text 
you 're sending properly 
displayed in the MacTerminal 
display area. Check Local 
Echo if you 're sending to 
another personal computer. 

See "Setting Up a New 
MacTerminal Document" 
earlier in this chapter. 



3. Choose File Transfer 
from the Settings 
menu. 

Set the File Transfer options 
as follows: 

• Leave File Transfer 
Protocol as is; for this 
operation, MacTerminal 
ignores that setting. 

• Leave Delay Between Chars 
and Delay Between Lines set 
at 0 unless Macintosh is 
sending data faster than the 
other computer can receive 
it. 

• Check Word Wrap 
Outgoing Text if you want 
MacTerminal to break a line 
at the end of a word rather 
than between characters. 

4. Start a 
communications 
session and prepare 
the other computer 
to receive data. 

See "Starting a 
Communications Session" 
earlier in this chapter. 

5. Choose Paste from 
the Edit menu. 

MacTerminal sends the text 
selection to the other 
computer, which will often 
echo the selection back to the 
terminal display area. If it 
doesn 't, check Local Echo in 
the Terminal dialog box from 
the Settings menu. 
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Communicating With Another Macintosh 

When using MacTerminal to communicate between two 
Macintoshes, or between a Macintosh and a Macintosh XL, 
you can send and receive any Macintosh file-a document, 
application, text file, or system file-by choosing File Transfer 
on the Settings menu, then checking MacTerminall.l. 

The MacTerminal disk provides a document named Macintosh 
that's preset to communicate between Macintoshes. Using this 
document, you'll only need to enter the phone number and 
perhaps change the baud rate. 

Also, before you actually call the other computer, choose the 
Save As command in the File menu and save the document's 
settings under a new name. That creates an empty document, all 
set to communicate with the other computer. From then on, start 
with that document, and-before collecting any data in it -save 
it again under a name that recalls the day's date , or the contents. 
That's so you won't clutter up your original "empty" document. 

1. On each Macintosh, 
open the Macintosh 
document and choose 
Compatibility on the 
Settings menu. 

Set the Compatibility options 
for both computers as 
follows: 

• Baud Rate-300 or 1200, 
depending on the slower 
modem; if the computers are 
directly linked, use 19200 (or 
any baud rate that works with 
the communications link). 

• Check the appropriate 
Connection and Connection 
Port options, depending on 
what's attached to the 
Modem Port or Printer Port. 

File Transfer Settings 

2. Choose Terminal 
from the Settings 
menu. 

Set the Terminal settings for 
both computers as follows: 

• Check VT100. 

• Check On Line. 

• If you're going to be 
sending with the Paste 
command, check Auto 
Wraparound and New Line, 
and go to step 4 of these 
instructions. 

Settings for Pasting or Sending TeHt: File Transfer Protocol 
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Delay Between Chars In 16DthS Second 

Delay Between lines ~ 60ths Second 

I3J Word Wrap Outgoing TeHt 

Settings for salling lines off top: 

I3J Retain line Breaks 

o Salle Screens Before Clearing 
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OTeHt 

o MacBinary 

o HModem TeHt 

@ MacTerminal 1.1 

o Straight HModem 



3. Choose File Transfer 
from the Settings 

~ menu. 

If you 're sending a file with 
the Send File command, go 
to the Settings menu, choose 
File Transfer, and make sure 
that the settings for both 
computers are as follows: 

• Choose MacTerminall.l as 
the File Transfer Protocol. 

• Check or uncheck Retain 
Line Breaks and Word Wrap 
Outgoing Text, depending 
on your preferences. 

By the way: If you 're pasting a 
selection from the Clipboard, 
MacTerminal ignores the File 
Transfer Protocol. 

4. Make the connection. 

ill If using phone lines, 
choose Phone Settings on the 
Phone menu and type in the 
phone number of the other 
Macintosh. Then choose the 
Dial command on the Phone 
menu . 

• If connecting directly, 
make sure the cable is in 
place 

5. Send a file, receive 
one, or type a message. 

. Just type. Anything you 
type on either computer 
immediately shows up on 
both screens. 

• You can send a file by using 
the Send File command. 

• You can send a short 
passage by using the Paste 
command. 

• You can receive a file sent 
by the other Macintosh. 

For more information on 
sending data, see "Sending a 
File" and "Sending a Small 
Amount of Text" earlier in 
this chapter. 

~Edit Commands Settings Phone Keypad 

Macintosh 

RppleLine ~ 

~~!g~!rcial S ... ~I Send I;J Terminal 

I magewriter Eject 
Letter 

IIIII! ~I Cancel Drille 
Report 

IQ I 
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Communicating With Another Personal 
Computer 

When communicating between a Macintosh and another 
personal computer, the communications parameters must be the 
same for both computers. You may need to experiment with the 
Compatibility and Terminal settings before successfully sending 
or receiving data . Once you've had a successful transmission, be 
sure to save the MacTerminal document so you can use the same 
settings again. 

Because direct communications like this require that you 
arrange with the other person a time when you' ll be sending 
or receiving data, most people prefer to use communications 
networks, such as MCI Mai l. A remote computer functions as 
the clearinghouse for incoming and outgoing "mail" or files . 
At your convenience, you can send fil es to others and pick up 
files sent by others on the same network. 

1. Open a new 
MacTerminal 
document and choose 
Compatibility from the 
Settings menu. 

Communications parameters 
differ depending on the 
terminal emulator and 
modem used by the other 
computer. Here's a common 
configuration to start with: 

• Baud Rate: 300. 

• Bits per Character: 7 bits. 

• Parity: None. 

• Handshake: None. 

• Connection and 
Connection Port settings 
depend on what's attached 
to the Macintosh's Modem 
and Printer ports. 
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2. Set the Terminal 
Settings for both 
computers as follows: 

• Check TTY as the 
recommended terminal type. 

You 'll probably want to set 
the terminal type to TTY to 
avoid problems you might 
encounter if the other 
computer's application can't 
communicate with a more 
sophisticated terminal like 
the DEC VT100 . 

• Check Local Echo, Auto 
Wraparound, and New Line . 

These features properly 
display the text in the 
MacTerminal display area. 
If the other computer 
provides these features, and 
you 've also checked them in 
MacTerminal, you'll see the 
problem as the data appears 
in the terminal display area. 
See "Troubleshooting" in 
Chapter 3 to fix the problem. 



3. Choose File Transfer 
from the Settings 
menu. 

• Choose Text or XModem 
Text as File Transfer 
Protocol. 

• Check Word Wrap 
Outgoing Text if you want 
MacTerminal to break a line 
at the end of a word rather 
than between characters, 

4. Make the connection. 

• If using phone lines, 
choose Phone Settings on the 
Phone menu and type in the 
phone number of the other 
Macintosh, Then choose the 
Dial command on the Phone 
menu, 

• If connecting directly, 
make sure the cable is in 
place, 

• Log on if necessary. 

See "Starting a 
Communications Session," 
earlier in this chapter, for 
more details, 

5. Send a file, receive 
one, or type a message. 

. Just type , Anything you 
type on either computer 
immediately shows up on 
both screens, 

• Send a file by using the 
Send File command, 

• Send a short passage by 
using the Paste command , 

• To receive using the Text or 
MacTerminal 1,1 protocols, 
do nothing at your end, If you 
are using the Mac Binary, 
XModem Text, or Straight 
XModem protocols, set 
Receive File on the File 
menu, 

For more information on 
sending data, see "Sending a 
File" and "Sending a Small 
Amount of Text" earlier in 
this chapter. 

File Transfer Settings 

Settings for Pasting or Sending TeHt: File Transfer Protocol 

Delay Between Chars ~ 60ths Second 

Delay Between lines ~ 60ths Second 

1:8] Word Wrap OutgOing TeHt 

Settings for sauing lines off top: 

1:8] Retain line Breaks 

o Saue Screens Before Clearing 

@TeHt 

o MacBinary 

o HModem TeHt 

o MacTerminal 1.1 

o Straight HModem 
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Copying Data From MacTerminal to 
Another Document 

A new MacTerminal document is preset to record incoming or 
outgoing data as the data scrolls off the top of the terminal display 
area (although you can set it not to). You can select all or any part 
of the data in the MacTerminal document and then copy it 
to a desk accessory or the document of another Macintosh 
application. If you've logged on to a data base, for example, 
and received a table of statistics, you can put the table into a 
report you 're working on in a Macintosh word processing 
application or spreadsheet. 

When you receive files with the Mac Binary, XModem Text, and 
Straight XModem protocol from another Macintosh or any other 
computer, MacTerminal displays a gauge (rather than the text) 
that shows you the progress of the transmission. Once the 
transmission is complete, the file appears in the Finder when 
you quit MacTerminal. 

Some applications let you move the contents of a MacTerminal 
document directly into their documents without selecting and 
copying the data. You save your document to the disk that has the 
application you want. Then you quit MacTerminal and return to 
the Finder. Select both the MacTerminal document icon and the 
application icon (click one icon, hold down the Shift key, and 
click the other) . Choose Open from the File menu. A new 
document for the application opens with the data from the 
MacTerminal document in its window. 

1. Open a MacTerminal 
document and set its 
options so you can 
communicate with the 
other computer. 

See "Setting Up a New 
MacTerminal Document" 
earlier in this chapter. 

• Be sure Record Lines Off 
Top from the Command 
menu is chosen, and you see 
Don't Record Lines Off Top. 

• On the Settings menu, 
choose File Transfer. If you 
are going to receive from 
a mainframe that sends a 
screenful of information at a 
time, check Save Screens 
Before Clearing. In the same 
dialog box, choose whether 
you want to retain line breaks 
or not. Refer to "Retain Line 
Breaks" in Chapter 3. 
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2. Start a 
communications 
session, and prepare 
the other computer 
to send files. 

See "Starting a 
Communications Session" 
earlier in this chapter. 

When you begin to receive 
data, MacTerminal saves it 
as it scrolls off the top of the 
display area. 



3. Select the data you 
want to copy. 

• Choose Select All in the 
Edit menu to select all data 
in the document. 

Or 

• Select a portion of the data 
by dragging across it or by 
selecting an insertion point at 
one end of the text you want 
to select, positioning the 
pointer at the other end of the 
data (scroll if necessary), 
holding down the Shift key, 
and cl icking where you want 
to end the selection. 

4. Choose Copyor Copy 
Table from the Edit 
menu. 

• Choose Copy if you're 
copying paragraphs of text. 

• Choose Copy Table if 
you're copying a table to 
Excel, shown below, or to 
certain other spreadsheet 
applications . 

The Copy Table command 
changes the spaces between 
tabular text to tabs so that a 
table appears in the correct 
format when you paste it 
into some spreadsheet 
applications that require tabs 
between columns. 

When you choose Copy or 
Copy Table, MacTerminal 
places a copy of the selection 
on the Clipboard . 
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5. Quit MacTerminal. 

• Terminate the connection, 
if you want to, by typing the 
log-off command(s) if the 
other computer requires you 
to. Quit MacTerminal by 
choosing Hang Up from the 
Phone menu if you're using a 
Modem and then choosing 
Quit from the File menu . 

Copying Data From MacTerminal to Another Document 

6. Open the other 
application's 
document and paste 
the data where you 
want it. 

• The application for the 
document you're opening 
must be on a disk in one of the 
disk drives or you won't be 
able to open the document. 

• Open a new or existing 
document for the application 
you want to use. 

.. Follow the pasting 
procedures for the 
application. 
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Printing 

You can select data in a 
current MacTerminal 
document and print the 
selection, or you can select 
a MacTerminal document in 
the Finder and print any data 
you saved in it. You can also 
copy data to another 
application's document and 
print it from there. 

If you have more than one 
printer attached to your 
Macintosh, you may need to 
select the one you want to 
use. Use Choose Printer or 
Chooser on the Apple menu . 

1. Choose Page Setup 
from the File menu. 

These settings are saved 
when you save the document. 

If you 're printing data wider 
than 80 columns, use the 
following settings: 

Wide Orientation and 
US Letter for data up to 
124 columns. 

Wide Orientation and 
US Legal for data up to 
132 columns. 

You won't use the Tall 
Adjusted option in 
MacTerminal. 

ImageWriter (1/11) 

Paper: @ us Letter 
o US Legal 

2. Select what you want 
to print. 

Select by dragging (or by 
using Shift-click). 

If you want to select more 
than what's in the terminal 
display area, click where you 
want to begin selecting; 
scroll if necessary; hold 
down the Shift key; and click 
where you want to end the 
selection. 

To extend a selection, scroll if 
necessary, then hold down 
the Shift key and click where 
you want to end the selection. 

Or 

Choose Select All from the 
Edit menu to select all the 
data in the MacTerminal 
document. 

o R4 Letter 
o International Fanfold 

o Computer Paper 

Orientation: @ Tall 0 Tall Rdjusted 0 Wide 

3. Choose Print 
Selection from the 
File menu. 

If you're printing on a single 
sheet at a time, click Cut 
Sheet and OK in the dialog 
box to start the printing 
process, and then click OK 
after each sheet is inserted. 
Don 't remove a sheet until 
the printingprocess is 
complete; the ImageWriter 
must move through a sheet 
to the end of the page even 
if it isn't printing any text. 
See "Print Selection" in 
Chapter 3. 

I( OK 

( Cancel 1 

Pagination: @ Normal pages 0 No breaks between pages 

Reduction: @ None 0 50 percent 

ImageWriter v2.1 

Paper: @ us Letter o R4 Letter 
o US Legal o International Fanfold 
o Computer Paper 

Orientation Special Effects: D Tall Rdjusted 
D 50 % Reduction 
D No Gaps Between Pages 

v2 .0 

(( OK lJ 

( Cancel 1 
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Opening 
MacTerminal 
Documents 

You open a new MacTerminal 
document or an existing one 
from the Finder or from a 
MacTerminal document by 
using the File menu. 

To Open a New 
MacTerminal 
Document 

From the Finder: 

Select the MacTerminal 
application and choose 
Open from the File menu (or 
double-click the application 
icon). 

Or, from a MacTerminal 
document: 

Choose Close from the File 
menu to close the current 
document. A dialog box lets 
you name an untitled 
document or save any 
unsaved changes before 
closing. 

Choose New from the File 
menu. A new MacTerminal 
document appears. You 'll 
name it the first time you 
save it. 

To Open an EXisting 
MacTerminal 
Document 

From the Finder: 

Select a MacTerminal 
document; choose Open 
from the File menu (or 
double-click the document). 

Or, from a MacTerminal 
document: 

Choose Close from the File 
menu to close the current 
document. 

Choose Open from the File 
menu . A dialog box appears. 

If the document is on a 
different disk, click the Eject 
button and insert the other 
disk. If you have two disk 
drives, insert the disk in the 
other drive, or click Drive to 
switch between drives. 

Select the MacTerminal 
document by clicking its 
name in the list of documents 
that appears. 

Click the Open button, or 
double-click the document 
name. 

enin? acTerminal Documents 

To Quit MacTerminal 

Choose Quit from the File 
menu. 

A dialog box lets you name an 
untitled document or save 
any unsaved changes before 
quitting. 

45 



Saving a Document 

MacTerminal only temporarily remembers changes you make to 
a document's settings; to keep these settings, save the document 
on the disk . When you save a document for the first time, its 
settings and current data are saved. From then on, MacTerminal 
automatically saves any data it's recording to the copy of the 
document on the disk. If you erase data in the document, 
MacTerminal automatically erases the same data on the disk. 

o Save As lets you name an untitled document and save it either 
to the disk you started with or to another one. It also lets you 
rename the open document, creating a new document on the 
disk (under the new name) without replacing the old one. 

o Save updates the copy of the document on the disk with the 
current changes. If the document is untitled , Save lets you 
name it and save it either to the disk vou started with or to 
another one. ' 

Saue as: 

Saue iJ 
L 

To Save an Untitled 
Document 

iii! Choose Save As (or Save) 
from the File menu. A dialog 
box appears that lets you 
name an untitled document. 

Type a name for the 
document. 

You can use al1\' character or 
symbol on the keyboard 
except a Tab, Return , or 
colon (:). You can use 
uppercase or lowercase 
letters and put spaces 
between words. 

III Click the Save button or 
press the Return key. 

If the disk is full , you 'll get a 
warning message. Save the 
document on another disk or 
remove some documents 
from the current one. 

Terminal 

Eject 

Cancel Driue 
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To Save a Document on 
a Different Disk 

lIS Choose Save As from the 
File menu. (The Save 
commancllets you save a 
document on a different disk 
only if you're naming the 
document for the first time.) 

The current name of the 
document appears selected 
in the dialog box. To change 
it, type a new name. 

... Click the Eject button and 
insert the other disk. If you 
have two drives, insert the 
disk in the other drive. If 
you 've already inserted a disk 
in the other drive, click the 
Drive button to switch 
between disks. 

. Click the Save button or 
use Return. 

MacTerminal saves the 
document to the disk named 
in the dialog box. With one 
disk drive, you swap disks 
a few times until the save 
process is complete, ending 
with the original disk in the 
drive. 



Copying a 
Document or 
Application From 
One Disk to 
Another 
With MacTerminal, you send 
fi les that you've created in 
other Macintosh 
applications. If you find that 
you 're frequently using an 
application to compose 
documents to send­
MacWrite , for example­
you may want to keep it on 
the MacTerminal startup disk 
or keep MacTerminal on 
another application's startup 
disk. 

You can copy a document, 
folder, or application to a 
different disk as long as the 
icon of the disk you 're 
copying to is present. 

1.lf necessary, insert 
the disk you want to 
copy to, so its icon will 
be present. 

2. Select the icon that 
represents the 
document, folder, 
or application you want 
to copy. 

If necessary, choose By Icon 
from the View menu , and 
scroll unti l the icon is visible. 

You can drag or Shift-click to 
select more than one icon to 
copy. 

Compare the size of the 
document or application to 
the space remaining on the 
destination disk. 

• With the document or 
application selected, choose 
Get Info from the File menu. 
Note the number of bytes 
available after Size. 

Some appl ications show 
you size in bytes, others in 
ki lobytes or K (K is the 
number of bytes divided by 
1,024 and rounded off) , and 
some in both. 

!I Look in the upper-right 
corner of the destination-disk 
window for the amount of 
room on the disk (expressed 
in K-13K, for instance). 

If the destination disk is too 
full , start a new disk or drag 
the files you don't want to the 
Trash icon and choose Empty 
Trash from the Special menu. 

3. Drag the icon to the 
place you want the 
copy togo. 

You can drag it to a folder 
icon, disk icon, folder 
window, or disk window. 

The destination disk can be 
arranged by icon or by any 
other arrangement. 

If you're using a one-drive 
system, the Macintosh 
presents a series of dialog 
boxes, asking you to insert 
alternately the disk you're 
copying from and the disk 
you're copying to . 

If the destination disk already 
contains an item with the 
same name, you 'll be asked 
to confirm that you want to 
replace the current contents 
with what you're copying. 
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In addition to the standard Apple menu, MacTerminal has six menus: File, Edit, 
Commands, Settings, Phone, and Keypad. The File and Edit menus contain the 
same basic commands for managing and editing documents that all Macintosh 
applications use, plus some extra commands specific to MacTerminal. And 
MacTerminal uses some of the basic commands in a unique way. For instance, 
because you can't cut data from a MacTerminal document, the Cut command 
in the Edit menu is active only for desk accessories. The last four menus­
Commands, Settings, Phone, and Keypad- contain commands specific to 
MacTerminal. 

Any command that requires additional information from you (or has helpful 
information for you) appears with three dots ( ... ) after it. When you choose 
these commands, a dialog box appears with a message or with areas for you to 
enter information and check options. You click a button, such as OK or Save, 
or use the Return key to confirm the command. Clicking the Cancel button 
retracts the command and leaves the options as they were when you chose the 
command. 

Commands or their options are dimmed if they're inappropriate at a given 
moment. For example, the Close command is dimmed if there's no open 
window on the desktop . 

About MacTerminal. .. 

Choose Printer 
Scrapbook 
Rlarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
Puzzle 

The Apple menu provides you with information about the program and printer 
you 're currently using, and your keyboard, plus any desk accessories residing 
in your system file . 
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About MacTerminal 
This command shows you information about MacTerminal and your current 
communications session, such as the number of characters stored off the top of 
the terminal display area in the open document, and the amount of space free 
on the disk. 

MacTerminal'H 

Uersion 2.0 of December 6, 1985 

- -by Mike Boich and Martin Haeberli 

© 1983, 1984, 1985 Apple Computer, Inc. 

o characters are stored off top. 

59392 characters are free on the disk. 

Desk Accessories 
Choosing any of the desk accessories causes that accessory to appear on the 
desktop as the active window. You can use the Edit menu to cut ( or copy) 
the information from most accessories and paste it into another accessory, 
a document of another Macintosh application, or a MacTerminal document. 
During a communications session, pasting into a MacTerminal document 
sends the data to the other computer, just as if you 'd typed it on the keyboard. 

The Note Pad is a useful accessory during a communications session when you 
don't want to take the time to open another application. You can compose a 
short note or message in the Note Pad during a session, cut or copy the note, 
and then send it by pasting it into a MacTerminal document. (See the section on 
the Paste command under "Edit Menu," later in this chapter.) 

The desk accessory stays on the desktop as an active or inactive window until 
you close it, either with its close box or with the Close command from the File 
menu. Macintosh, your owner's manual, has instructions for using desk 
accessories. 
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Saue 
Saue As ... 

Send File ... 
Receiue File •.. 

Page Setup ... 
Print Selection ... 

Quit 

The File menu contains commands for managing documents while in the 
MacTerminal application. 

New 
Opens a new, untitled MacTerminal document. You can choose Newonly after 
closing the current document. 

Open 
Opens a document stored on a disk. A dialog box presents a list of MacTerminal 
documents on the disk named in the box. You open a document by clicking the 
document name and then the Open button (or by double·clicking the name). 

Apple Cluster ... ~ 

:::::~:~: Sup ... ~ 
Hard Disk 
Macintosh 

, ... -iim: 

Open 

Cancel 

Terminal 

Eject 

Driue 

The Eject button ejects the disk named in the dialog box. If you have two 
disk drives with a disk in each and eject the disk named in the dialog box, 
MacTerminal automatically switches to the disk in the other drive and shows 
you its name and list of documents. If you insert a disk again into the empty 
drive, MacTerminal switches back to that disk. 

The Drive button lets you switch between drives when you have more than one 
drive with a disk inside. 
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Close 
Closes the active window. If the MacTerminal document window is the 
active window and you 've changed settings or other information in the menu 
commands, a dialog box appears and gives you the opportunity to save 
the changes. 

Save 
Saves the document you 're working on and its settings and lets you name and 
save an untitled document. Once you 've saved a document, use this command 
when you 've changed settings in the menu commands and want to save the 
changes on the disk. See " Save As," immediately following, for an explanation 
of naming a document and saving on a different disk. 

The first time you save a document, MacTerminal saves any data in the 
document along with the settings. Afterward, if you set MacTerminal to record 
incoming data as it scrolls off the top of the display, MacTerminal records it in 
the open document and automatically saves it to the copy on the disk. (See 
"Record Lines OffTop" under " Commands Menu," later in this chapter.) If the 
other computer is a mainframe sending one screen full of information after 
another, you can save whole screens. (See "Settings For Saving Lines Off Top" 
under "File Transfer Settings" in Chapter 3.) You don't need to save your 
document regularly to save data, only to save setting changes. If you decide to 
erase data that MacTerminal has recorded in the open document, MacTerminal 
also erases it from the copy of the document on the disk. (See "Clear Lines Off 
Top" under "Commands Menu".) 

Save As 
Saves the document you 're working on, its settings, and any data- under the 
name you specify and to the disk named in the dialog box. The Eject and Drive 
buttons let you save a document to another disk. 

When you first name a document or save it under a different name, a new 
document is stored on the disk with that name, and a new icon is created in the 
Finder. Use the Save As command when you want to save the document you 're 
working on as a separate document and keep the old version on the disk, 
or when you want to save a document to another disk (or do both) . 

Salle as: Terminal 

Eject 

Cancel Drille 
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When you save an untitled document, a dialog box appears with a place for you 
to type a name. You can use any character except a colon, Return, or Tab in the 
name for the document. After naming a document, you save it to the disk 
named in the dialog box by clicking the Save button. If a document already 
exists with that name on the disk, you're asked to confirm that you want the 
document you're saving to replace the existing one. 

The first time you save a document, MacTerminal saves any data in the 
document alongwith the settings. Afterward, if MacTerminal is set to record 
data, it automatically saves the data to the copy on the disk as it records the data 
in the open document. If you decide to erase data that MacTerminal has 
recorded, MacTerminal also erases it from the document on the disk. (See 
"Record Lines Off Top" under "Commands Menu, later in this chapter.) 

The Eject button ejects the disk named in the dialog box. If you have two drives 
with a disk in each drive and eject a disk from one, MacTerminal automatically 
switches to the disk in the other drive and shows its name in the dialog box. 
If you insert a disk again into the empty drive, MacTerminal switches back to 
that disk. 

The Drive button lets you switch between drives when you have more than one 
drive with a disk inside. 

Send File 
Sends a file from a disk to another computer. A dialog box presents a list of all 
appropriate files on the disk named in the box. The Eject and Drive buttons let 
you send a file from another disk. 

Rpple Cluster ... 
RppleLine 
RppleLine SUP ... :!!!!! 

~:~~~;~ial s ... IIIIII 

Macintosh mm 

Send 

Cancel 
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The types of files listed-documents, applications, text files, or system files­
depend on the File Transfer protocol you checked in the File Transfer dialog 
box from the Settings menu. 

o If you checked Text or XModem Text, only text files appear. 
(All MacTerminal documents are text files .) 

o If you checked any other protocol, you see all the Macintosh files on 
that disk-documents, system files, and applications. 

When you select a file, then confirm the command by clicking Send or pressing 
the Return key, MacTerminal sends the file to the other computer. 

o If you're sending a file with the Text protocol, you may see the text displayed 
on your screen, if the other computer echoes it. (If the other computer 
doesn't, you can display the text by going to the Settings menu, choosing 
Terminal, and turning on Local Echo.) 

o If you're using any other File Transfer protocol, a gauge appears showing 
you the progress of the transmission; you will not see the actual text appear 
on your screen. 

~11111111111111111111111111111111111111111111111111111111111111111111111111'1I1111I11I1I 111111111111 
o 25 50 75 100 

You can stop a transmission by holding down the Command key and then 
pressing the period (.) key. 

The Eject button ejects the disk named in the dialog box. If you have two drives 
with a disk in each and eject a disk from one, MacTerminal automatically 
switches to the disk in the other drive and shows its name and appropriate files 
in the dialog box. If you insert a disk again into the empty drive, MacTerminal 
switches back to that disk. 

The Drive button lets you switch between drives when you have more than one 
drive with a disk inside. 
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Receive File 
Prepares MacTerminal to receive a file sent with the MacBinary, XModem Text, 
or Straight XModem protocols. With these File Transfer protocols, you must 
choose Receive File from the File menu, and name the file. 

Make sure that the disk or folder named in the dialog box is the one you want 
this file to be saved on. If not, use Drive and Eject to switch to other disks and 
folders. 

When you see the right disk's name in the dialog box, name the incoming file 
in the space provided. Click Receive, or press the Return key. If a file already 
exists with that name on the disk, you 're asked to confirm that you want the new 
file to replace the existing one. 

After you click the Receive button, MacTerminal waits approximately 1 Yz 
minutes to receive the file. If you 're communicating by modem, you choose 
Wait For Call. When the other computer calls and starts to send the file, a gauge 
indicates the progress of the transmission. MacTerminal receives the file and 
sends it immediately to a disk; the file does not appear in the terminal display 
area. When you quit MacTerminal, the file with the name you specified will be 
on the disk you specified. 

The command is dimmed unless you have checked Mac Binary, XModem Text, 
or Straight XModem as the File Transfer protocol you want, in the File Transfer 
dialog box from the Settings menu. 

File Name: Terminal 

I Price 
Eject 

(Receiue 1 Cancel Driue 
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Page Setup 
Lets you specify the size of paper you 'll be printing your document on; whether 
it will be printed across the width of the page or sideways across its length; 
whether or not to divide the text into pages; and whether or not to reduce the 
size of the type. 

A dialog box presents the various options. For example, to print data that is 132 
character-columns wide, check US Legal and Wide to print across the length of 
an8Yz- by 14-inchpage. You can print up to about column 124 across the length 
of 8Yz- by II -inch paper. The preset options are checked as follows: 

8Y2 by 14 inches European Standard 
8 \4 by 112/3 inches 

8Y2 by 11 inches International Standard 
8\4 by 12 inches 

I mag "Citer (1/11) I( OK )) 
ji) US letter - 6 A4 letter 

US legal International Fanfold [ Cancel 1 o Computer Paper 

Orientation: Tall Tall Adjusted Wide 

Pagination: @ Normal ages 0 No breaks tween pages 

Aeduction: @ None 050 percent v2.0 

Not used in 
MacTerminal 

Text is primed with the top 
line at the top of the page 

MacTenninal Commands 

Text is printed siclways on 
the page, with the top line 
down the right side 
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The Tall Adjusted option isn't used with MacTerminal. In other Macintosh 
applications, you use it to print correctly proportioned geometric figures. 

8Yz by 14 inches 

8Yz by 11 inches 

iter 

@ US letter 
US Legal 

European Standard 
8\4 by 112/3 inches 

International Standard 
8\4 by 12 inches 

v2.1 

R4letter 
International Fanfold 

o Computer Paper 

Orientation Tall Rdjusted 
50 % Reduction 
No Gaps Between Pages 

Prints on continuous or 
computer paper without 
top or bottom margins 

Not used with Shrinks text to 
MacTerminal small font 
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Print Selection 
Prints what is selected in the MacTerminal document. A dialog box presents the 
various options with the preset ones checked as follows: 

Highest Quality Printing 

Screen-Quality Printing: 
Faster than High quality 

Draft-Quality Printing: 
Faster than Screen-Quality 

ImageWriter (I II) ( OK l) 
Prints all pages in the ----H...;;.;;.;;.;.;.~-_ 

Quality: High • Standard (!) Draft 

Page Range: • RII o From: c=J To: c=J [ Cancel 1 document , first to last 
Here you specify how -----+-+.-...... ---Copies: EJ 

Paper Feed: (V Rutomatic <f Hand Feed v2 .0 
-.. many copies of the 

document to print I 
Feeds paper Allows you to feed each sheet 
nonstop indiVidually 

To stop printing, hold down the Command key and press the period (.) key. 

Quit 
Closes the MacTerminal document, if open, and returns you to the Finder. 
If the document is untitled, you 're given the opportunity to name and save it. 
Or, if you've changed settings or other information in the menu commands 
since last saving the document, you 're given the opportunity to save the 
changes. See "Save As ," earlier in this chapter, for more information about 
saving settings and data. 

MacTerminal Commands 61 



• EditMenu 

62 

[ !it 
Copy 
Copy Table 
Paste 
[!P!H 

Select HII 

Show CI 

Undo 
Undoes the effects of your most recent action. In MacTerminal, you can choose 
Undo only when working with desk accessories. Undo is dimmed when a 
MacTerminal document window is active. 

Cut 
Removes a selection from a desk accessory and places it on the Clipboard, 
replacing the Clipboard's contents, if any. You can't cut data from a 
MacTerminal document. You can only copy a selection to place it on the 
Clipboard. (Copy and Copy Table are described next) . Cut is dimmed 
when a MacTerminal document window is active. 

Copy 
Copies a selection from a MacTerminal document or a desk accessory and 
places it on the Clipboard, replacing the Clipboard's contents, if any. You can 
use Copy to copy any selected text; however, if you're copying tables, choose 
Copy Table. 

Copy Table 
Copies a table selected from a MacTerminal document and places it on the 
Clipboard, replacing the Clipboard's contents, if any. Copy Table transforms 
the spaces between two columns into tabs so that data remains in columns 
when you paste a table into certain spreadsheet applications that require tabs to 
set up columns. Some Macintosh spreadsheet applications, like Microsoft 
Excel, will paste a table in its proper format only if the table has tab characters 
separating the columns. Use Copy Table for this type of application. 
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Paste 
Sends the text in the Clipboard to the other computer when you paste it in a 
MacTerminal document. If you paste something into your document, and do 
not see anything on the screen, the other computer may not be "echoing" back 
whatever you send; in this case, to see what you're pasting, go to the Settings 
menu, choose Terminal, and click Local Echo. (Remember that by itself Local 
Echo does not send anything.) In desk accessories that accept text, Paste 
replaces the current selection with the contents of the Clipboard or inserts 
the contents at the insertion point or in the space available. 

Clear 
Removes a text selection from a desk accessory without placing it on the 
Clipboard. Clear is dimmed when the MacTerminal document window 
is active. 

Select All 
Selects all data currently in the MacTerminal document. Select All is dimmed 
if the MacTerminal window is not active. To turn off the selection, click 
anywhere within the document. 

Show Clipboard/Hide Clipboard 
Show Clipboard displays the contents of the Clipboard (what you most 
recently cut or copied) . When the Clipboard window is open, this command 
changes to Hide Clipboard. 

The Commands menu contains commands that affect the operation of 
MacTerminal while you're in a communications session. You'll choose some of 
these commands as a response to a situation created by the other computer. 

Reset ... 
Slop )Cl'oHin9 
Un!oc\( 

Record Lines Off Top/Don't Record Lines Off Top 
The preset option is Record Lines Off Top. When Record Lines Off Top 
is chosen, its alternate, Don't Record Lines Off Top, shows. 

MacTenninal Commands 63 



64 

o Record Lines Off Top-MacTerminal records lines of data in the open 
document and automatically saves them to the copy of the document stored 
on the disk as the lines scroll off the top of the terminal display area (or off the 
top of a shorter scrolling area defined by the other computer's application). 
If you haven't named and saved the document, MacTerminal stores the 
data in a temporary file until you save the document. You can choose this 
command in the middle of a session, to record only the interesting part. 
If you are receiving information from a mainframe application that sends 
one screen of information at a time and clears it without scrolling up, you 
must also go to the Settings menu, choose File Transfer, and then choose 
Save Screens Before Clearing. Otherwise, screens full of data get lost. 

o Don't Record Lines Off Top-MacTerminal stops recording data in the 
document and saving it to the disk. This command does not erase data that 
has already been recorded. 

When recording lines or saving screens, MacTerminal saves the data to disk. 
When that disk becomes full in the middle of a session, MacTerminal turns off 
the Record Lines Off Top command and stops saving the information to the 
disk. To save the rest of your session, go to the File menu and choose Save As. 
Eject the current disk, insert another, and click Save. Turn Record Lines Off 
Top back on again. Incoming data will be saved to the document on the 
new disk. 

Clear Lines Off Top 
Erases the data that MacTerminal has recorded off the top of the terminal 
display area (or off the top of a shorter scrolling area defined by the other 
computer's application) . At the same time, MacTerminal erases the same data 
from the document on the disk. A message appears that asks you to confirm 
the command. If you are sure of what you 're doing, you can avoid the 
confirming message by holding down the Option key while you're choosing 
the command. 

Reset 
Erases the data in the terminal display area and returns the settings you changed 
during a communications session to the way they were when you opened or 
last saved the MacTerminal document. This command has the same effect as 
a reset command sent from a host computer. A message appears that asks you 
to confirm the command. If you are sure of what you're dOing, you can avoid 
the confirming message by holding down the Option key while you choose 
the command. 
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• Settings Menu 

Start Scrolling/Stop Scrolling 
The preset option is Start Scrolling. When Start Scrolling is chosen, its alternate, 
Stop Scrolling, shows. 

Stop Scrolling stops the display of incoming data; Start Scrolling starts it again. 
Stop Scrolling and Start Scrolling are equivalent to the VT1 00 Control -S and 
Control-Q sequences that interrupt and resume the display of data on the 
screen. These commands are dimmed unless the Handshake protocol 
x On/X Off is checked in the Compatibility dialog box in the Settings menu. 

Unlock Keyboard 
Enables MacTerminal to resume sending data. Use this command when the 
remote computer has sent an X Off command and "locked" MacTerminal's 
keyboard. With MacTerminal, a locked keyboard prevents you from issuing 
any commands from the keyboard except Control-S (to tell the other computer 
to stop sending data). Unlock Keyboard is dimmed unless the keyboard is 
locked. 

The Status Lights option for the VT100 terminal type (Settings menu: 
Terminal) shows the status of the keyboard. When you see the Kbd Locked 
indicator "light" turned on, the other computer has locked the keyboard. 

nal. .. 
Compatibility ... 
File Transfer ... 
Rnswerbacl< Message ... 
Character Sets ... 
Keyboard ... 

Show Tab Ruler 

The Settings menu contains commands that present the options you need to set 
up MacTerminal to communicate with the other computer. 

MacTerminal Commands 65 



66 

Terminal Settings E 
The Terminal command options allow you to designate the type of terminal 
MacTerminal emulates and to choose some terminal features. Choosing this 
command shows a dialog box listing the options; click to choose the ones you 
want. Choosing a terminal type dims those options that won't work with the 
terminal you've chosen. 

Terminill Settings 

Terminill @UT100 o TTY o IBM 3278 

Mode @HNSI OUT52 

Cursor Shilpe @Underline o Block 

line Width @80 Columns o 132 Columns 

Protocol Conu o flpp!eUm~ o C!U~tN I: tl r 

[gJ On line o LOCill Echo o Stiltus lights 

[gJ Huto Hepeilt o Huto Wrilpilround o New line 

o Repeilt ctrls o 'fftlnsp<lrenl 0 [Cilncel) 

Terminal 
The preset option for a new document is VT100. 

o VT100-MacTerminal emulates the DEC VT100. 

o TTY -MacTerminal emulates the standard Teletype terminal, which 
ignores many commands from the remote computer that the VT100 can 
respond to. The TTY (Teletype) responds to Return, Tab, Backspace, 
and Line Feed characters and ignores other control characters and all 
escape sequences. 

o IBM 3278- MacTerminal emulates an IBM 3278 terminal linked to an IBM 
mainframe through the AppleLine or an Apple Cluster Controller. 

Mode 
The preset option is ANSI. 

You have a choice of modes only if you are emulating a VT100. The VT52 is an 
older model of the VT1 00. 
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Cursor Shape 
The preset option is Underline. 

D Underline- The cursor is a blinking underscore. 

D Block-The cursor is a blinking solid rectangle. 

Line Width 
The preset option is 80 columns. 

MacTerminal's display area can be 80 or 132 columns wide by 24 lines long. 
A column is equal to one character in the Macintosh 9-point Monaco font , 
the font MacTerminal uses as the basis for its own custom font. 

Changing the line width erases the terminal display area and returns the cursor 
to the top left of the screen. . 

Use the horizontal scroll bar to scroll to the 132nd column. 

Protocol Conv 
The preset option is Apple Line. Protocol Conv (Converter) applies only to the 
IBM 3278. 

D Apple Line-The Macintosh is attached to an IBM control unit or mainframe 
through the AppleLine. 

D Cluster Ctlr (Controller)- The Macintosh is attached to an IBM control unit 
or mainframe through an Apple Cluster Controller. 

See Appendixes C and D for more information on these two devices. 

Online 
The preset option is checked (on) . 

D Checked (on)- When you start a communications session, MacTerminal 
is connected to and accessible to the other computer. 

D Unchecked (ofO- MacTerminal stops communicating with the other 
computer without terminating the connection (a condition called "off­
line"). This allows you to do something else in the terminal display area, 
in a desk accessory, or in another application. MacTerminal displays all the 
characters you type . Checking the option resumes communication with 
the remote computer. 

The Status Lights option for the VII 00 terminal type shows whether On Line 
is checked or not (see « Status Lights,' , below) . 
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Local Echo 
The preset option is unchecked (off). 

D Checked (on)-All characters you type on the keyboard or numeric keypad 
(or select from the Keypad menu, described in "Keypad Menu," later in this 
chapter) are displayed locally by MacTerminal. Check Local Echo when the 
other computer specifies half duplex in its communications parameters 
(that is, when the other computer does not echo back your keystrokes). 

D Unchecked (off)-MacTerminal does not display characters as you send 
them. If you are sending or receiving in Full Duplex, all characters you type 
on the keyboard or numeric keypad (or select from the Keypad menu) 
are echoed back by the other computer rather than by MacTerminal. 
Turn Local Echo off when the other computer specifies full duplex in its 
communications parameters (that is, when it echoes back your keystrokes). 

The Status Lights option for the vn 00 terminal type shows you whether 
Local Echo, displayed as "Local," is checked or not. (The Status Lights option 
is described next.) 

Status Lights 
The preset option is unchecked (off). Status Lights applies only to the 
DEC VT100. 

D Checked (on)-MacTerminal displays a panel of status lights like those on 
a DEC VT1 00 terminal. The panel is displayed at the top of the document 
window under the title bar. 

D Unchecked (off)-MacTerminal does not display the DEC VT100 status 
lights. 

Shows whether On Line and _~_~ __ " 
Local Echo are on or off 

Shows whether the ___ -+-! ______ -" 

keyboard and menu 
commands are locked 
(see Unlock Keyboard 
in the Commands menu) 
The remote computer's __ +-~ _______ ,--..... _~",...,,~. 

application controls the 
meaning of these lights 
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Auto Repeat 
The preset option is checked (on). 

o Checked (on)- A character repeats when you hold down a character key. 
The Repeat Ctrls option must be checked also for control keys, such as the 
Tab, Return, and Backspace keys, to repeat. You can specify the rate of repeat 
with the Control Panel in the Apple menu. 

o Unchecked (off) - Characters don't repeat when you hold down a character 
key. 

Auto Wraparound 
The preset option is unchecked (off). 

The Auto Wraparound option affects the appearance of incoming text in 
MacTerminal's terminal display area. 

o Checked (on)-When the cursor reaches the 8Ist or I33rd column, 
MacTerminal automatically returns it to the first column. Uncheck this 
option if the other computer provides this feature. You usually use the 
Auto Wraparound feature with the New Line option described next. 

o Unchecked (off) - When the cursor reaches the 8Istor I33rd column, 
the cursor stops, and incoming characters write over the last character on the 
line. 

Newline 
The preset option is unchecked (off). 

o Checked (on)-When MacTerminal receives a Line Feed character from 
the other computer, the cursor moves to the first position on the next line. 
When you press Return, MacTerminal sends both a Return and a Line Feed 
character. Use this option when incoming data does not move down to 
the beginning of the next line. 

o Unchecked (off)-When MacTerminal receives a Line Feed character from 
the other computer, the cursor moves down one line and stays in the same 
column. When you press Return, MacTerminal sends onlya Return 
character, which moves the cursor to the first position on the same line. 
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Repeat CtrIs 
The preset option is unchecked (off). Repeat Ctds (Controls) is dimmed 
unless Auto Repeat is checked. 

o Checked (on)-A control character repeats when you hold the character 
key down. Control characters are Tab, Return, Backspace, and all keys 
pressed with the Command key. 

o Unchecked (off) - A control character doesn't repeat when you hold down 
the character key. 

Transparent 
The preset option is unchecked (off). Transparent applies only to the TTY. 

o Checked (on)-Control characters appear as sequences of two or three 
characters in the terminal display area. Control characters don't function 
when they're displayed. 

o Unchecked (off) - Control characters are not displayed as characters but 
instead have their normal effect in the terminal display area. 

Compatibility Settings 
The Compatibility command options allow you to set up MacTerminal to 
communicate with the other computer so that data is sent and received with a 
minimum of error. MacTerminal and the other computer must be set with the 
same communications parameters. 

Compatibility Settings 

Baud Rate 050 075 0110 0134.5 

0150 0200 0300 0600 

@ 1200 01800 02000 02400 

03600 04800 09600 019200 

Bits per Character 0 7 Bits @ 8 Bits 

Parity 0 Euen 0 Odd @ None 

Handshake 0 HOn/HOff @ None 

Connection @ Modem 0 Another Computer 

Connection Port @ 1«01 0 I~I ~ r.::=:;I 

~~ 
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Baud Rate 
The preset option is 1200. 

The baud rate is the speed at which data passes to and from the remote 
computer- usually the number of bits sent per second. MacTerminal and the 
remote computer must transmit at the same speed. Most modems transmit at 
300 or 1200 baud over telephone lines. You usually use the other speeds for 
transmitting to a computer that is directly connected by cable. 

Garbled incoming data, or no data at all , can sometimes mean the baud rate set 
for MacTerminal doesn't match the other computer's. 

Bits per Character 
The preset option is 8 bits. 

This option refers to the number of bits that comprise a character. MacTerminal 
can send and receive 7 -bit or 8-bit characters, whichever the other computer 
requires. Some computers require a "start or stop bit" setting; MacTerminal 
sets these automatically when you set Bits per Character. 

Parity 
The preset option is None. 

Parity refers to the way MacTerminal and the remote computer check that data 
isn't garbled in transmission. MacTerminal has three parity options: Even, 
Odd, and None. MacTerminal does not have mark parity or space parity. 

Parity errors are printed as rectangular boxes. 

Handshake 
The preset option is None . 

The Handshake protocol is often called the XOn/ XOff protocol. The other 
computer must support the Handshake protocol for you to use it. 

o X On/ X Off-Regulates the flow of data between the Macintosh and the 
other computer. Using X On/ X Off prevents the loss of data when either 
MacTerminal or the other computer sends characters faster than the other 
can receive them. Usually you won't need to use XOn/ XOfffor a baud rate 
of 1200 or slower. However, some commercial services, such as MCl Mail, 
require Handshake for controlling data flow. 

XOn/ XOff lets you use Start Scrolling or Stop Scrolling in the Commands 
menu . 
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o None-MacTerminal doesn't regulate the flow of data from the other . 
computer, nor does MacTerminal respond to the other computer's attempts 
to regulate the flow of data from MacTerminal (MacTerminal ignores 
X On/X Off sent by the other computer.) If the remote computer sends 
information faster than MacTerminal can receive it, characters will be 
missing from incoming data. You can try a slower baud rate if the Macintosh 
is directly connected to the other computer. Or try using Don't Record Lines 
Off Top from the Commands menu to speed up MacTerminal's ability to 
process incoming data. 

You'll usually want to use the Handshake protocol for baud rates over 1200 
if the other computer supports the protocol. 

Connection 
The preset option is Modem. 

o Modem-MacTerminal communicates with the other computer through 
a modem. The Modem option activates the Phone menu. 

o Another Computer-MacTerminal communicates with the other computer 
through a cable or tie line attached to another computer. 

Connection Port 
The preset option is the Modem port. 

The Connection Port options specify which port on the back of the Macintosh 
you 're using to attach the cable to the modem or the other computer. The 
option icons are the same as those that identify the ports on the back of 
the Macintosh. 

Printer port ------i-o_--------+------"" 

Modem port -----+------++-------------

Macintosh Macintosh Plus 
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Although you can use either the Printer port or the Modem port, the Modem 
port is usually recommended for sending data to another computer, whether 
MacTerminal is sending through a modem or a direct tie line. Some hard disks 
are designed to be connected to the Modem port, in which case you must use 
the Printer port to connect your modem or tie line. In this case only, use the 
Hard Disk document to open a session. The Apple Hard Disk 20 connects to 
the External Disk drive port, leaving the Modem port free . 

The Printer port works well for data transmitted at speeds up to and including 
1200 baud. If you're sending data at speeds faster than 1200 baud, you may lose 
some data in the transmission depending on the type of hard disk you have 
connected to the Modem port. Check with your authorized Apple dealer or 
the hard disk manufacturer for information on using the hard disk with 
MacTerminal. Also, see "Using MacTerminal With a Hard Disk," later in this 
chapter, for more information on using MacTerminal with a hard disk drive. 

File Transfer Settings 
The File Transfer options let you set up MacTerminal in various ways to send 
and receive data. 

File Transfer Settings 

Settings for Pasting or Sending TeHt: File Transfer Protocol 

Delay Between Chars ~ 60ths Second @ TeHt 

Delay Between lines ~ 60ths Second 0 Mac Binary 

[8J Word Wrap Outgoing TeHt 0 HModem TeHt 

o MacTerminal 1.1 

Settings for sauing lines off top: 

[8J Retain line Breal<s 

o Saue Screens Before Clearing 

MacTerminal Commands 
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Settings for Pasting or Sending Text 
These options let you adapt the speed and format of what you send, 
to accommodate the other computer. 

Delay Between Chars and Delay Between Lines 
The preset option for each is none. 

These options let you specify a delay between characters or lines being sent to 
another computer that can't receive data as fast as the Macintosh is sending it. 
You use this option when you can'tadjustthe baud rate. You 're likely to use this 
option when communicating with a private computer system, rather than a 
large public information service. Try experimenting with the delays until you 
find a setting that works. Start by setting a delay between lines and then try 
a delay between characters. 

Word Wrap Outgoing Text 
The preset option is checked (on). 

Word Wrap Outgoing Text applies only to sending text files or pasting 
(sending) text into a MacTerminal document. 

D Checked (on)-At the end of the line (an 80- or 132-column line, 
depending on the Line Width option that's set), the cursor and the last word 
that won't fit wrap to the beginning of the next line: MacTerminal will break 
the line between words rather than between characters. A word is any group 
of characters separated from other characters by at least one space. 

If you've inserted Returns in the text to create narrower margins, the line 
breaks where you inserted the Return. This option only affects lines that have 
a return before the 80th column (or 132nd column). 

D Unchecked (off) - After the last character in the line, the cursor and the 
following character move to the next line. 
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Settings for Saving Lines Off Top 
These options let you define what information to save, and how to format the 
line breaks. 

Retain Line Breaks 
The preset option is checked (on). 

o Checked (on)-MacTerminal records the Return character (at the end of 
each line sent) from the other computer when MacTerminal records data. 

o Unchecked (off)-MacTerminal does not record the Return character. 

You use this feature in conjunction with Record Lines Off Top (Commands 
menu) . When you set MacTerminal to record incom ing data, you can have it 
retain or remove the Return character as it's recording the data. Your choice 
depends on how the other Macintosh application uses the Return character to 
define the format of text. MacWrite , for example, uses a Return to define a 
paragraph. If you copy a paragraph to MacWrite from MacTerminal and if the 
paragraph has a Return character at the end of each line, MacWrite will treat 
each line as a separate paragraph. 

Save Screens Before Clearing 
The preset option is unchecked (off) . 

o Checked (on)- MacTerminal saves the contents of each screen full of 
information before clearing the screen. 

o Unchecked (off) - MacTerminal does not save the contents of the screen; 
it just clears the screen. 

Use this feature when you are communicating with a mainframe application 
that sends a screen full of information, then clears it, without scrolling. To save 
the screens, you must also have turned on the Record Lines Off Top option on 
the Commands menu. 

To browse through the material you save, use the scroll bar. Click in the gray 
part of the scroll bar above the scroll box to see one screen at a time. 
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File Transfer Protocols 
The preset option is Text. 

Each protocol represents an agreement between two computers about how 
they will exchange data. 

o Text-MacTerminal sends and receives the file as a sequence of ASCII 
characters, without any information about format or font. When you choose 
the Text protocol, and then choose Send File on the File menu , MacTerminal 
provides you with a list of text files-only. Many Macintosh applications give 
you the option of saving a document as a text file. For example, MacWrite has 
a Text Only button in its Save As command, and Multiplan has a SYLK 
button. Some applications' documents are automatically saved as text files. 
Use Text when emulating an IBM 3278, or when the other computer can 
receive only ASCII files and does not support any of the other protocols. 

o MacBinary- Use this method to transfer any Macintosh file (a document, 
---l- an application, or a system file) to or from any computer that supports a 

protocol called XModem. The XModem protocol, based on a method 
developed by Ward Christensen, is an agreement to send data and keep on 
sending data until it gets there; it checks for errors, to make sure your file 
arrives intact. You can use MacBinary to transfer files from one Macintosh to 
another, but before you receive a file this way, you must use the Receive File 
option in the File menu. 

In general, use MacTerminall.l to transfer files between Macintoshes; 
use MacBinary to send a file to an information service, so another Macintosh 
can pull it back and lise it. 

o XModem Text -Use with computers that support the XModem protocol, 
but do not understand the formatting information in a Macintosh file. Unlike 
mere Text transfer, this method checks for errors. And it keeps your 
paragraphs intact, adding a line feed signal after each Return so that the other 
computer moves down to the next line before starting the next line of text. 
When YOll are receiving text with this method, the Macintosh strips those 
line feeds out. 

o MacTerminall.l-Use this method to transfer any type of file between two 
Macintoshes. The Macintosh document that comes with your MacTerminal 
disk is already set to this option. !fyou want to receive a file later, and can't be 
at the computer to enter the necessary commands, use MacTerminall .l , 
then choose Wait For Call on the Phone menu. 

o Straight XModem- For programmers only. Use this method to transfer the 
data portion of a file to another computer that supports the XModem 
protocol. 
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Answerback Message 
Presents a dialog box in which you specify a message identifying MacTerminal 
to another computer (usually a host computer) that requires it. The other 
computer specifies what the message must be. You may need to send an 
answerback message when you 're communicating with certain types of private 
computer systems. Most public information services don't require it. 

The message can be comprised of any series of characters up to 40. Some 
answerback messages require a control character- for example, the control 
character - M designates a Return character. You type the control character by 
using the Shift key to type the caret ( - ) above the number 6 key on the main 
keyboard and then typing the appropriate letter. 

If you 've already entered an answerback message, it appears selected 
(highlighted) , and you can replace it by typing another. 

Answerback Message OK ~l 

( Cancel 1 

You can also use the answerback message when you 're communicating with 
another Macintosh or other personal computer. It's a convenient way to let the 
other computer know that you 've made contact. 

When communicating with a large computer system, MacTerminal sends the 
message you 've specified when the other computer requests it. Or you can 
send it yourself. 

D Control-Enter sends the answerback message: Hold down Control (the 
Command key) and press Enter. MacTerminal sends the message. 

D Control-E asks for the message: Hold down Control and press E. 
The computer at the other end automatically sends its answerback 
message. 
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Character Sets 
Instead of the normal complement of Macintosh fonts, MacTerminal has two 
built-in sets of characters it can display on its screen: GO, the primary set, and 
G 1, the alternate set. The Character Sets command lets you choose between 
the two sets, as well as specify each set from a collection of standard, special, 
and foreign character sets. You 'll usually use only the character set appropriate 
for your country and language; you might, however, need the Graphics 
character set to do on-screen graphics, or a German character set to 
communicate to a multilingual mainframe. 

Character Set Settings 

Currently Actiue: @ GO 0 G 1 

GO Character Set: 

o Graphics @ US Ascii 0 UK Ascii 0 Norwegian 

o French 0 Spanish 0 German 0 Danish 

o French-Canadian 0 Italian 0 Swed. Finn. E47 

o AIL ADM Graphics 0 Alt. ROM 0 Swed. Finn. 047 

G1 Character Set: 

o Graphics @ US Ascii 0 UK Ascii 0 Norwegian 

o French 0 Spanish 0 German 0 Danish 

o French-Canadian Oltaliiln 0 Swed. Finn. E47 

o Alt . ROM Graphics 0 Alt. ROM 0 Swed. Finn_ 047 

~ (cancel) 

Note that the optional character sets normally available on the Macintosh with 
the Option key (and seen with the Key Caps desk accessory) are not usable 
in MacTerminal. 

Currently Active 
The preset option is GO , which is VTl 00 talk for primary. 

MacTerminal can display characters from two character sets simultaneously, 
althou gh you can receive (or type) characters in only one set at a time. 
The Currently Active setting lets you control which character set incoming 
(or typed) characters will be shown in. 
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GO Character Set 
The preset option is US ASCII. 

This set of options lets you choose from among 14 character sets to use for the 
primary character set. 

o US ASCII- The standard set of letters, numbers, and symbols used in 
North American English computers. 

o UKASCII- The same as US ASCII but with the pound sterling symbol (£) 
instead of the number sign (#). 

o Graphics- The set of graphics characters used to create line drawings on 
a VT1 00 terminal. 

o Norwegian, French, Spanish, German, Danish, French-Canadian, Italian, 
Swedish/ Finnish E 4 7 and D4 7 -Various character sets with accented 
characters. Note that the keyboard layout for these character sets follows the 
DEC standard and may be different from the Macintosh keyboard layout for 
that country. 

o Alternate ROM Graphics and Alternate ROM-character sets used in special 
versions of the VT100 terminal. 

G 1 Character Set 
The preset option is US ASCII. 

This set of options lets you choose from among 14 character sets to use for the 
alternate character set. The choices for Alternate Character Set are the same as 
the choices for Primary Character Set, above. 

Keyboard Configuration 
The preset option is that pressing Backspace alone yields backspace; 
pressing Command-backspace yields delete. 

You can choose to have the Backspace key work as a Delete key or as a 
Backspace key. Command-Backspace gives you the alternate function . 

Keyboard Configuration 

Backspace Key 

@ Backspace alone yields backspace; 3€-backspace yields delete. 

o Backspace alone yields delete; 3€-backspace yields backspace. 
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o The first option means that pressing the Backspace key will simply back you 
up one space. Pressing the Control key at the same time as the Backspace key 
will back up one character, and delete it. 

o The second option reverses that. Pressing Backspace eats up a character, ~ 
and moves you to the left; pressing the Control key at the same time as the 
Backspace key backs you up one character, without deleting it. ~ 

Show Tab Ruler/Hide Tab Ruler 
The preset option is Hide Tab Ruler. Its alternate, Show Tab Ruler, shows in the 
menu of a new MacTerminal document. 

Show Tab Ruler presents a ruler showing tab markers preset every eight 
characters, or wherever you set them. A tab marker determines where the 
cursor moves when MacTerminal receives a tab character from the other 
computer. The tabs on the tab ruler affect only incoming data. Click under 
the ruler's scale where you want to add a tab; click on a tab to remove it. 

If you know the other computer is sending a table with tab characters 
separating the columns, you must change the tab ruler before the table is sent 
to change the number or spacing of columns in the table. A sophisticated 
application on the host computer might set tabs for you. 

Most tables that other computers send use spaces rather than tabs to separate 
the columns. If you copy a table into another application that requires tabs 
between columns (like Excel), you can change the spaces to tabs by copying 
the table with the Copy Table command from the Edit menu. You can alter the 
spacing or number of columns once you've pasted the table into the 
application. See "Copy Table" earlier in this chapter. 

" File Edit Commands Settings Phone Keypad 

o MacTerminal Document 
10 20 30 40 50 60 70 80 0 

I I I I I I I 11 II. I I II I I I III I I I I I I I II I I I II I I I II I I I II I I I I. I I III I I I I. ' .. ' I II I I I I. I I I I I I I I Ill-=­. . . . . . .~. . ~ 

- -- -- -- - --- --- ---- - -
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• PhoneMenu 

-., 

The Phone menu contains commands for specifying the other computer's 
phone number, for dialing the number and hanging up, and for receiving a call 
from another computer. This menu is dimmed unless the Connection option 
Modem is checked in the Compatibility dialog box (Settings menu) . The 
commands in this menu work with the Apple modems or Apple-compatible 
modems. If you have another type of modem, you may be able to command 
your modem from MacTerminal by using the keyboard. Refer to "More About 
Modems," later in this chapter, for more information. 

If you use the Cancel button in each of the dialog boxes associated with the 
Phone commands, you'll notice that a few seconds elapse before the command 
is canceled. 

Hang Up 
Wait For Call ... 
Phone s ... 

Dial 
Signals the modem to dial the phone number you entered in the Phone 
Settings dialog box (Phone menu). A message tells you that MacTerminal 
is calling, and then tells you whether or not MacTerminal connects. 

Hang Up 
Signals the modem to terminate the telephone connection. A message tells you 
that MacTerminal is hanging up. 

Wait For Call 
Signals the modem to wait for a call from another computer and presents a 
message telling you that MacTerminal is waiting for a call. When the phone 
rings, the modem answers it on the third ring unless you have changed the 
setting in the Phone Settings dialog box (Phone menu). The dialog box 
disappears as soon as the modem answers the phone. 
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E: 
Phone Settings E: 
The Phone Settings command is dimmed if Another Computer is checked 
in the Compatibility dialog box (Settings menu). 

Phone Settings 

Phone Number 

19,8005551212 

Dial @Tone o Pulse o MiHed 

Number of Rings Before Rnswer ~ 

Modem 0 Rpple 300 @ Rpple 1200 0 Other 

o [cancel) 

Phone Number 
Allows you to specify the access number for the other computer. If you 've 
already entered a number, it appears selected (highlighted) , and you can 
replace it by typing another. 

A comma after a number causes the modem to pause before dialing the 
remaining numbers. Use a comma when entering a number used to get an 
outside line or whenever you dial a number and then wait for a dial tone. 
Refer to your modem manual for further information on giving instructions 
to your modem. 

Dial 
The preset option is Tone. 

Tone, Pulse, and Mixed are types of transmission signals used by telephone 
companies. Tone is the most common in use today and is used with most push­
button telephones. Pulse is used with many rotary-dial telephones and is still 
found in parts of the United States. Mixed (a combination of both tone and 
pulse) is used where a tone system exists within a building but the region 
still uses a pulse system (or vice versa). 

If you have a mixed system in your area, part of the phone number will be tone 
(usually the part that gets you an outside line- 9, for instance), and part will be ~ 
pulse. When you type the phone number, type an uppercase T before the tone 
numbers and an uppercase P before the pulse numbers. For example: 
T9,P4155551212. 
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• Keypad Menu 

--. 

Number of Rings Before Answer 
The preset option is 3. 

This feature lets you specify the number of times you want the telephone to 
ring before the Apple modem answers (when you use Wait For Call in the 
Phone menu). You can designate any number of rings between 0 and 255. 
See your modem manual for details. 

Modem 
The preset option is Apple 1200. 

These options let you specify whether you're using an Apple 300, an Apple 
1200, or another type of modem. 

The Keypad menu contains keypad layouts for the Macintosh. The keypad that 
appears depends on which terminal is checked in the Terminal dialog box 
(Settings menu). If VT1 00 or TTY is checked, you'll see the Macintosh 
numeric keypad. If IBM 3278 is checked, you 'll see a wide keypad with 
IBM 3278 function keys. 

o The Macintosh numeric keypad provides the cursor keys and some of the 
function keys for the DEC VT100 terminal. To see the function keys, 
press the menu title, Keypad. 

IPF IPF2 IpF3 PF· VT100 function keys 

7 8 9 -

4 5 6 . 
1 2 3 E 

n 

ir t 

0 e 
r 
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o To see the cursor keys, hold down the Command key to the left of the space ~ 
bar and press Keypad. Use this keypad if you don 't have a Macintosh numeric 
keypad. 

VTl 00 cursor keys 

7 8 9 l' 

4 5 6 -J,. 

2 3 E 
n 
t 

0 e 
r 

o The other keypad provides the function keys for the IBM 3278 terminal. 
See "The Macintosh Keyboard" in Appendix C for an explanation of these 
function keys. 

Choosing a "key" on any of these menus is like pressing one of the special keys 
on a VT100 or an IBM 3278 terminal. To choose a key, you position the pointer 
on the menu title , press the mouse button, drag to the key you want, and release 
the mouse button. 

If you have a numeric keypad, and you are emulating a VT1 00, the top four keys 
act as PF keys 1 through 4. To turn / , *, -, and + into the Left-Arrow, Right­
Arrow, Up-Arrow, and Down-Arrow keys, hold down the Command key at the 
same time that you press the key. 
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If you have a numeric keypad you can use it to duplicate the PF (programmable 
function) keys on the IBM 3278 terminal. In the diagram, note that there are 
three levels: you get one set of PF equivalents simply by pressing the key, 
another by pressing the Command key at the same time as you press the key, 
and a third by pressing the Option key at the same time as you press the key. 
When MacTerminal emulates an IBM 3278 terminal, the Return key is 
equivalent to the New Line key. 

Not U$'ld Not UHd 

PF23 PF24 

i:J1P ... a 
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Using a Some host computers have applications that use a full screen of data at a time- ~ 
Full-Screen usually 24 or 25 lines. With some applications, lines of data don't scroll above 
Application the terminal display area as you might expect; instead, when you change ~ 

information in the display, the host computer redisplays the entire screen. 
E With other applications, lines of data scroll (if necessary) to readjust the display 

whenever you change information. 

Full-screen applications take advantage of the DEC VT100 features , 
particularly the cursor keys that let you move the cursor around on the screen to 
edit data. MacTerminal uses the Macintosh numeric keypad in the same way 
and provides you with an equivalent of the numeric keypad in the Keypad 
menu. You press on the menu title, Keypad, and then drag to the key you want. !'; 
o To see the function keys on the numeric keypad, press the Keypad. 

o To see the cursor keys, press the Command key and then the Keypad. 

In addition to the cursor keys on the numeric keypad, you can use the mouse to E 
position the cursor; position the pointer where you want the cursor to move, 
and hold down the Option key and click the mouse button. The host computer """-

may move the cursor more slowly than you would like. Be patient. If you click !: 
too many times in the same spot, MacTerminal beeps to tell you to stop. 

If the host computer's application allows you to position the cursor directly, 
you can send the cursor to the new position by the most direct, diagonal route. 
Press Command· Option at the same time that you click the mouse button at 
your new position. 

To avoid overtaxing the host computer, you can also set the speed at which the 
cursor moves to the new position. On the Settings menu, choose File Transfer, 
and set the Delay Between Characters at number one. Gradually increase the 
delay until you reach the speed you want. 

~ 

~ 

~ 

~ 

~ 

!t 
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More About 
Modems 

Compatible Modems 
MacTerminal's Phone menu is designed to be used with Apple modems and 
Apple-compatible modems, such as the Hayes Smartmodem 1200TM, and the 
U.S. Robotics Autolink™. All of these modems are in the general category of 
"intelligent" modem- those that can be commmanded from the keyboard or, 
in this case, from communications software like MacTerminal. 

Commanding a Modem 
Many modems, both compatible and noncompatible, can be commanded to 
dial and hang up from the keyboard. You can type commands to any intelligent 
modem and circumvent the Phone menu whenever a MacTerminal document 
is open and not in a communications session. Refer to your modem manual for 
the dialing commands to use. 

Your Modem and Your Telephone 
When your modem is on and you're communicating with another computer, 
someone calling you will get a busy signal. When your modem is on and you're 
not in a communications session, and your modem answers the phone before 
you do, someone calling you will get a high-pitched tone that lasts a few 
seconds. Your caller may be disconcerted by your modem's greeting, but you 
can carryon a conversation after that first brief shriek without turning off the 
modem. If do want to turn it off, be sure you pick up the telephone receiver 
first, and then turn off the modem. If you turn the modem off first, you 'll be 
disconnected. 

The Apple Modem 300 and Apple Modem 1200 are set at the factory to answer 
your telephone after the first ring unless instructed differently. The Apple 
Personal Modem is set at the factory to answer the phone after zero rings­
essentially, not to answer it at all , unless you use the SO command to tell it 
when to answer. MacTerminal's Phone Settings option Number of Rings 
Before Answer lets you reset the modem as follows: 

o The modem will answer the phone after the number of rings you specify 
from 0 to 255 

o The modem will not answer your phone at all unless you instruct it to 
"Wait for Call." 

The numbers 1 through 255 reset the modem until you turn the modem off. 
Each time you turn your modem off, you'll need to start MacTerminal in order 
to let the Number of Rings Before Answer option set the modem with whatever 
number is specified there. 
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If you are using an Apple Hard Disk 20, attach it to the external disk drive port. 
You may copy MacTerminal onto the HD20 and run it from there. Do not start 
with the Hard Disk document, though. That's for people whose hard disk is 
connected to the Modem port. 

If you have a hard disk attached to the Printer port or to the External Disk Drive 
port, do not use the Hard Disk document for a communications session. 

If your hard disk is connected with the Modem port, connect your modem 
or direct tie line to the Printer port on the back of the Macintosh. 

o Don't move your MacTerminal application onto the hard disk. 

o Don't open a new document or use any of the preset documents except 
Hard Disk. Use the Hard Disk document as a template for setting up a 
communications session. After you 've made any necessary changes to 
the settings and entered the access number, use the Save As command from 
the File menu to save the document under a different name so you preserve 
the template and still save your new settings for later use. 

The Hard Disk document is preset to communicate through the Printer port. 
If you open a document that's preset to communicate through the Modem 
port -as is any new document, or the Commercial Services document­
you may damage some data on your hard disk. 

The Hard Disk document settings are exactly the same as those for a new 
document and the Commercial Services document, except for the Port 
Connection option in the Compatibility dialog box (Settings menu). 
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Troubleshooting 
--. 

--. 

Most problems you encounter while using MacTerminal are caused by a 
MacTerminal document whose communications parameters don't match 
the other computer's. Most problems show up as soon as you start a 
communications session and begin to send or receive data. 

Sometimes you'll have difficulty getting the session started at all. One of the 
more common problems between personal computers trying to communicate 
is getting the connection established by modem, particularly between an 
Apple modem and another type. You and the other person must be sure you 
both have the correct cables, that the cables and telephone lines are properly 
plugged in, and that the modem switches are set correctly. 

"Noise" or static on the telephone lines is another common problem you'll 
encounter when communicating by modem to any other computer. Noise can 
cause garbled data or any number of other problems. There's nothing you can 
do about noise except to start over and hope the telephone lines behave 
themselves. 

Nothing gets sent or received. 

o Make sure all cables are properly connected. 

o If you 're using a modem, make sure it's on. 

o Make sure On Line is checked (Settings menu: Terminal). 

o Check that the Baud Rate setting matches the other computer's setting 
(Settings menu : Compatibility). 

o Try changing either Bits per Character or Parity, or both (Settings menu: 
Compatibility) . 

Nothing appears on the screen when you send or receive data. 

o Check Local Echo (Settings menu: Terminal). 

o If you 're using MacTerminall.l , MacBinary, XModem Text, or Straight 
XModem protocols (Settings menu, File Transfer) , make sure your 
Terminal type is VTl 00 (Settings menu: Terminal) . 

o Make sure both computers are using the same file transfer protocols 
(Settings menu: File Transfer) . 
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Incoming data is missing random characters. 

o Check the X On/ X Off option for Handshake (Settings menu: 
Communications) , 

o If the remote computer doesn't support the Handshake protocol and if your 
Macintosh is directly connected to the other computer, try experimenting 
with slower baud rates, 

If your modem or tie line is connected to the Printer port, you may lose data 
at baud rates over 1200, Use a file transfer protocol that checks for mistakes 
(all do except Text) whenever possible , 

Incoming data is garbled. 
Try changing the communications parameters (Settings menu: 
Compatibility) , 

o Make sure the Baud Rate setting matches the other computer's, 

o Try changing either Bits per Character or Parity, or both, 

Lots of rectangular boxes appear in the incoming data. 
Try another parity setting until the transmission is normal (Settings menu: 
Compatibility) , 

Incoming data writes over the last character on the first line. 
Check Auto Wraparound and New Line (Settings menu: Terminal) , 

The data appears as double characters. 
Uncheck Local Echo (Settings menu: Terminal), 

Lines of incoming data are double-spaced. 
Uncheck New Line (Settings menu: Terminal) , 

Incoming data writes over the same line. 
Check New Line (Settings menu: Terminal), 

Incoming characters disappear off the edge of the screen. 
Check Auto Wraparound (Settings menu: Terminal), 
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Appendix A: 
Keyboard Layouts 

The Macintosh 
Keyboard 

When you are emulating the VT100, MacTerminal redefines three keys on the 
main Macintosh keyboard to act as the Control key, the Escape key, and the 
Break key. 

o The Command key, located to the left of the space bar, is the Control key. 

o The key located in the upper-left corner of the keyboard is the Escape key. 
To get the grave accent character (-), hold down the Command key and 
press the Escape key. To get the tilde ( ~ ), hold down the Command key and 
the Shift key, and press the Escape key. 

o The Enter key functions as the Break key when pressed at the same time as 
the Option key. Press Option-Enter to send a break to the host computer. 

o To send a long break, hold down the Shift key and press Enter. 

You can set the way the Backspace key works by choosing Keyboard on the 
Settings menu. When pressed, the Backspace key can either back up your 
cursor one space, or delete what it backs up over. You can decide which you feel 
most comfortable with. The other function is then available when you press the 
key while holding down Control. 

Escape key -----+-

Option key -----+---

Control key -----+---~ 
Command key ----+-----' 
Enter key -------!-----------------.../ 
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E: 
MacTerminal also redefines certain keys on the Macintosh numeric keypad to E: 
act like the function keys on the VT1 00 numeric keypad or IBM 3278. If you 
have set up your Macintosh to act as a VT1 00, the Keypad menu provides the ~ 
equivalent of the VT100 numeric keypad. If you don't have the Macintosh 
numeric keypad, use the Keypad menu as follows. 

o To use the function keys, press on the menu title, Keypad, and drag to the key 
you want. 

o To use the cursor keys, hold down the Command key, press Keypad, 
and drag to the key you want . 

• ·1.1 
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If you have a numeric keypad, MacTerminal redefines the keys on the numeric 
keypad to act like the function keys on the IBM 3278, too, You get one set of PF 
equivalents simply by pressing the key, another by pressing the Command key 
at the same time as you press the key, and a third by pressing the Option key at 
the same time as you press the key. When MacTerminal emulates an IBM 3278 
terminal, the Return key is equivalent to the New Line key, 

I. I 

If you do not have a numeric keypad, and want to use the IBM-programmable 
keys, make sure your terminal is set to IBM 3278, Then pull down the Keypad 
and drag to the key you want. For an explanation of the programmable keys, 
see Appendix C. 

Not U:sd Not Usd. 

P.F23 P.F24 

'1iIIII 

Not U:Silol 

P.F2f ~
up 

PAf 

~1iIItWII 

lidd Hark 

Not U:SoIZd 

PFf3 PFf5 

'1iII '1iII 

Not US'\i!d. 

With the OptioD. Key 

With tile CruluINuld K cy _u.a. 
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The Macintosh 
Plus Keyboard 

When you are emulating the VT100, MacTerminal redefines three keys on the 
Macintosh Plus keyboard to act as the Control key, the Escape key, and the 
Break key. 

98 

o The Command key, located to the left of the space bar, is the Control key. 

o The key located in the upper-left corner of the keyboard is the Escape key. 
To get the grave accent character (-), hold down the Command key and 
press the Escape key. To get the tilde ( - ) , hold down the Command key and 
the Shift key, and press the Escape key. 

o The Enter key functions as the Break key when pressed at the same time as 
the Option key. Press Option-Enter to send a break to the host computer. 

o To send a long break, hold down the Shift key and press Enter. 

You can set the way the Backspace key works by choosing Keyboard on the 
Settings menu. When pressed, the Backspace key can either back up your 
cursor one space, or delete what it backs up over. You can decide which you feel 
most comfortable with. The other function is then available when you press the 
key while holding down Control. 

• •••••••••••• •••• •••••••••••• • • •••••••• • ••• • ••• ••• •••••• • ••• •••• • 
MacTerminal also redefines certain keys on the Macintosh Plus numeric 
keypad to act like the function keys on the VT1 00 numeric keypad or 
IBM 3278. 
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To use the cursor keys in VTl 00 mode, hold down the Command key and press 
the keys in the upper-right corner of your numeric keypad. 

The Keypad menu provides the equivalent of the VTl 00 numeric keypad. 
If you prefer, you can use the Keypad menu as follows. 

o To use the function keys, press on the menu title, Keypad, and drag to the key 
you want. 

o To use the cursor keys, hold down the Command key, press Keypad, 
and drag to the key you want. 

MacTerminal redefines the keys on the numeric keypad to act like the function 
keys on the IBM 3278, too. You get one setof PF equivalents simply by pressing 
the key, another by pressing the Command key at the same time as you press 
the key, and a third by pressing the Option key at the same time as you press the 
key. When MacTerminal emulates an IBM 3278 terminal , the Return key is 
equivalent to the New Line key. 

For an explanation of programmable keys, see Appendix C. 

~ 
Not U,:d Not UHd Not U$~d 

SpRee PF22 P.P23 P.P24 

811am1r iJJliIUID iJJliIUU iJJliIUI 

Id .. , 

~ 
Not U:sed 

~ PF.l9 P.P20 P.P2.1 PA.I 

iJJliI'rI iJJlilra iJJliIU ~1IIIiJlI.t 

ITJ Ho,,", 

~ 
l'uld.l'brk: 

PF.l7 PA2 

iJJ~ iJJliliI iJJliIl IDabla 

NotU:sd 

PF.l3 PF.lS 

iJJliIU iJJliIU 

Not U:S4d. Not U:sd. 

.DeVCtwceJ .l!nise IJJPU 

IBaEIl 1Jm(ll.~ 

With tM Option. Ko2y 

JY.itb the CrummuHf .Key 

_lIIbr .. 
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Appendix B: 
Attaching a 
Modem to the 
Printer Port With 
AppleTalk 

100 

Where possible, attach your modem to the Modem port. If that is occupied, and 
you have AppleTalk connected to your Printer port, then you'll need to attach 
your modem to the Printer port. Here's how: 

1. Click AppleTalk Disconnected in the Choose Printer or Chooser desk 
accessory and select the Printer port. 

2. Unplug the AppleTalk connector from the back of your Macintosh. 
(Never unplug the AppleTalk cables from the connection box; 
if you do, you'll disable the network.) 

3. Connect your modem to the Printer port. 
4. Change the setting in the Compatibility dialog box to Printer port. 

Do not try to attach AppleTalk connectors to any other port. 

• 
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AppendixC: 
Installing the 
AppleLine 

You 'll need the AppleLine User's Manual to complete the hookup of the 
AppleLine to your Macintosh. The following instructions assume that you have 
already completed the procedures in Chapter 2, Part I, of the AppleLine User's 
Manual, to connect the Apple Line to the IBM system. Before you start using the 
Apple Line with your Macintosh, you must do three more things: 

o Complete the hookup of the AppleLine. 

o Set MacTerminal to communicate correctly with the AppleLine. 

o Use the AppleLine 's supervisor program to enter irs passwords and 
communications parameters. 
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• Completing the 
Hookup 

You can connect your Macintosh to the AppleLine directly or through 
a modem. 

It's a good idea to test the system each time you finish connecting a new 
accessory. Turn on the system to make sure the new part is working. 

Direct Connection 
To connect your Macintosh directly to the Apple Line , you need a cable 
assembly that consists of a data cable attached to a gender changer. 
The assembly is packed with the AppleLine. 

The cable assembly has a pin-plug connector at one end and a pin-socket 
connector (the gender changer) at the other. Here's how to install it: 

1. Turn off both the AppleLine and your Macintosh. 

2. Attach the pin-plug connector to the Modem port on the back of your 
Macintosh and tighten the "ear" screws (if any) to secure the connection. 

The Modem port is usually recommended for data communications; 
however, if you have a hard disk connected to the Modem port, you can 
connect your modem to the Printer port. 

3. Attach the pin-socket connector on the gender-changer cable to the 
connector marked MODEM on the back of your AppleLine, and tighten 
the ear screws (if any). 

Macintosh ------+---------------!o!~ 00 

AppleLine ------+-------..".....:::.-

Gender changer ----+-------, 

Apple Modem data cable --+------------' 
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Modem Connection 
To communicate with an IBM or IBM -compatible mainframe by modem, you 
need two Apple modems-one connected at the Macintosh location and 
another connected to the AppleLine that 's connected to the mainframe. 

Apple Personal Modem --of-----------t 
Macintosh------+-----------iI!-+ 

AppleLine -------+----~~ 

To Mainframe -----k 

Apple Modem 1200---+----"';;O;"~-----" 

The data cable you need comes packed in the accessory kit with the Apple 
Modem 300 or Apple Modem 1200. In addition, you need the gender changer 
that was packed with your AppleLine. 

Hook Up the Modem to Your Macintosh 
You can use the Apple Modem 300, the Apple Modem 1200, or the Apple 
Personal Modem. 

Hook Up the Modem to the AppleLine 

1. Turn off the AppleLine. 

2. Plug the gender changer into the connector marked MODEM on the back 
of your AppleLine. 

3. Attach the large connector on the data cable into the gender changer, 
and tighten the ear screws (if any) to secure the connection. 

4. Attach the small connector to the 9-pin socket on the back of the Apple 
modem and tighten the ear screws (if any) . 
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• SettingUp 
MacTerminal 

104 

The MacTerminal disk provides a document named AppleLine that 's preset to 
communicate between your Macintosh and the AppleLine. If you use it and are 
directly connected to the AppleLine, you don 't need to change any settings. 
If indirectly connected by modem, you may need to reset the Baud Rate 
(described in step 2). Otherwise, when starting a new document, be sure the 
settings are as described here. 

1. Choose Terminal from the Settings menu. 

Set the Terminal options by clicking the circle, the square, or the name 
of the option you want. 

o Terminal Type-IBM 3278 

Options that do not apply to the IBM 3278are dimmed; others that apply are 
made bold. 

o Protocol Conv- AppleLine 

o Online-On 

o Auto Repeat -On 

o Auto Wraparound-Off 

o Repeat Ctds- Off 

The following figure shows the preset options for the Terminal command. 

Terminal Settings 

Terminal o unoo OllY @ IBM 3278 

Mode @ HN'>! o In:!? 

Cursor Shape @Underline o Block: 

Line Width @ BO [o!umns o ! 52: I: OhHH!lS 

Protocol Conu @ RppleLine o Cluster Ctlr 

181 On Line D t(!( !l! [( ho D S1<d \!~ Ughh 

181 Ruto Repeat 181 flu1 (! Wrdp<!l'(HHH! 181 Npw tine 

D Repeat Ctrls D lrll!lSpdrenl ~ (cancel] 
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2. Choose Compatibility from the Settings menu and set the Compatibility 

options: 

o If the Macintosh and the AppleLine are directly connected, set Baud Rate 
to 9600. 

Or 

o If they are connected through modems, set the baud rate to match the 
modems. If the modems have different baud rates, set Baud Rate to match 
the slowest modem. When you change your AppleLine 's communications 
parameters as described in Chapter 3, Part I, of the AppleLine User s Manual, 
set the baud rate to the same speed. 

o Bits per Character - 7 Bits 

o Parity-Even 

o Handshake-X On/ X Off 

o Connection-Another Computer 

o Connection Port-Modem Port 

The following figure shows the preset options for the Compatibility command. 

Compatibility Settings 

Baud Rate 0 50 0 75 0 110 0 134.5 

o 150 0 200 0 300 0600 

o 1200 0 1800 0 2000 02400 

03600 0 4800 @ 9600 0 19200 

Bits per Character @ 7 Bits 0 8 Bits 

Parity @ ElJen 0 Odd 0 None 

Handshake @ HOn/HOff 0 None 

Connection @ Modem 0 Rnother Computer 

Connection Port @ 1<?0'1 0 I J11 
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• Entering 
Passwords and 

106 

Communications 
Parameters 

After the AppleLine is hooked up and working, the first thing you should do 
is enter certain information into its memory. This requires two procedures: 

o Send the autobaud message and start the supervisor program, explained 
below. 

o Use the supervisor program described in Chapter 3, Part I, of the AppleLine 
User's Manual. 

The first time you use the AppleLine, you use the AppleLine Supervisor 
document to tell the Apple Line what baud rate your Macintosh is using. 
You do this by sending the AppleLine a special message that it can analyze to 
determine the rate. 

1. Turn on both your Macintosh and the AppleLine. 

2. Start MacTerminal and open the AppleLine Supervisor document. 
("Creating a New Apple Line Supervisor Document," later in this appendix, 
tells you how to set up a new Apple Line Supervisor document if you need 
to do that.) 

3. If you're communicating by modem, choose Phone Settings from the 
Phone menu and enter the telephone access number to the AppleLine. Set 
the Dial and Modem features. Then choose Dial from the Phone menu . 

4. Once connected and before typing anything else, hold down the Shift key 
and press the Enter key. Then press Return. You 've just sent the autobaud 
message. 

Your Apple Line responds by displaying an identification line across the top 
of your display area, followed by this message: 

Press RETURN to ~~gin thelog:on sequence .. . 

5. Press Return. 

Your AppleLine will reply with this message: 

Enter Password: 
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6. Type the word Apples and then press Return. 

This is the preset password to the AppleLine 's supervisor program. 
Your Apple Line replies with this message: 

• File Edit Commands Settings PtlorHl Keypad 

-D Rppleline 

App I eL i ne has been rese t to .. f ac tory " se tt i ngs . 
P I ease logon as App I eL i ne SUPERU I SOR us i ng the 
superv i sor password .. APPLES" to se t App I eL i ne to 
your part i cu I or conf i gurat i on. 

A terminal type must be selected before you 
continue. 

Poss i bl e sel ect ions: 

A - L i saTerm ina I 
B - MacTerm ina I 
C - Access -3270 
o - VT100 

Your se lecti on [Hec:TerminoI1 : 

101 

7. Type the letter B and then press Return. 

This tells the AppleLine that you 're using MacTerminal. Your AppleLine 
replies with this message: 

CurrentterrTlinal type is "MacTerminal , ' ~ Is thiscorrect[Y]7 _ 
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8. Press Return. 

Pressing Return accepts the preset response shown inside the brackets 
(in this case the 1': which stands for yes). Your Apple Line replies with this 
message: 

• File Edit Commands Settings Phorw KeYPild 

-D RppleLine 

App I eL i ne Superv i sor logged-ON 

Possible selections: 

PI 

A - Display termi nal type and modem settings 
B - Modify terminal type and modem settings 
C - Change USEA or SUPERV I SOR passwords 
D - Logo ff and hang up modem 
E - Logo ff and re turn to logon screen 

Your selection [Logoff and return to logon screen]: 

You are now ready to use the AppleLine's supervisor program. Refer to 
Chapter 3, Part I, of the AppleL ine User's Manual for a description of what the 
supervisor program does and how to use it. 
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• Creating a New 
AppleLine 
Supervisor 
Document 

• Using Your 
Macintosh as an 
IBM 3278 

You create a new Apple Line Supervisor document as follows: 

1. Open a new MacTerminal document. 

2. Leave the Terminal settings as they are, and change Compatibility as shown 
below. 

3. Use the Save As command from the File menu to name the document and 
save the settings. 

Compatibility Settings 

Baud Rate 050 075 0110 0134.5 

0150 0200 0300 0600 

01200 01800 02000 02400 

03600 04800 @9600 019200 

Bits per Character @ 7 Bits 0 8 Bits 

Parity @ Euen 0 Odd 0 None 

Handshake @ HOn / HOff 0 None 

Connection 0 Modem @ Another Computer 

Connection Port @ 1\?01 0 I~I ~ ~ 
~~ 

When the AppleLine is operating, you can use your Macintosh with 
MacTerminal to work with an IBM mainframe, just as if you were seated 
at an IBM Model 3278 terminal. A typical session consists of three parts: 

o Setting up communication between your Macintosh and the IBM system 
by a series of log-on procedures. 

o Working with the IBM system by typing messages on your Macintosh 
keyboard and reading replies on your Macintosh screen. 

o Terminating communication between your Macintosh and the IBM system 
by a series of log-off procedures. 

The first and third parts, logging on and logging off, are described in Chapter 5, 
Part I, of the AppleL ine User's Manual. The second part, using your Macintosh 
controls and keyboard to work with the IBM system, is covered in this section. 
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• Terminal Controls 

• The Macintosh 
Keyboard 

110 

The IBM Model 3278 terminal has the following controls for which the 
Macintosh has equivalents: 

o Knobs vary the brightness and contrast of the screen image and change 
the volume of the audible alarm. 

On the Macintosh, you adjust brightness with the control below the screen; 
you adjust the volume with the Control Panel in the Apple menu. 
(See Chapter 4, "Macintosh Reference," in Macintosh, your owner's gUide.) 
If you set the volume to zero, MacTerminal flashes the menu bar to signal 
that the host computer has sent a bell (beep). 

o A Dual Case/Mono Case switch determines whether your typing appears 
as uppercase and lowercase letters or uppercase (capitals) only. On the 
Macintosh keyboard, the Caps Lock key provides this function. 

When you type ordinary letters, numbers, and punctuation marks on your 
Macintosh keyboard, most IBM programs understand them in the normal way. 
They are exactly equivalent to the letters, numbers, and punctuation marks on 
the IBM 3278 keyboard. However, there are other keys on the 3278 keyboard 
that have special markings (such as SYS REQ and ATTN) that identify the 
special functions they perform. 

For the meaning and use of these special IBM function keys, consult the 
appropriate IBM manuals, particularly the IBM 3278 Display Station 
Operator's Guide. 

The Macintosh provides the equivalent of these function keys on a keypad in 
the Keypad menu . You can use these special functions by positioning the 
pointer on the Keypad menu title, pressing down the mouse button, dragging 
to the function key you want, and releasing the mouse button. 
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If you have a numeric keypad, you can use it to imitate the function keys on the 
IBM 3278. You get one set of PF equivalents simply by pressing the key, 
another by pressing the Command key at the same time that you press the key, 
and a third by pressing the Option key at the same time that you press the key. 

Not U:5'd. 

~
up 

PA.! 

~IIEII.I 

Not Used. 

With'he Op.io" Koy 

W.itfl tile CrJ.lBBMmI .Key _111.--
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Or you can activate these functions by pressing certain combinations of ~ 
standard keys on your Macintosh or Macintosh Plus keyboard. The IBM 3278 

~ Keyboard Equivalents Table lists these combinations, arranged in the order in 
which their functions are described in the IBM 3278 Display Station Operator'5 e: Guide. 

IBM Keys Apple Keystrokes IBM Keys Apple Keystrokes 
e: 

DUP I CONTROL I{Q] PF22 IESCAPEIITl e: 
FIELD MARK I CONTROL KYl PF23 I ESCAPEIG] 

PA1 I ESCAPEICD PF24 I ESCAPEIG ~ 
PA2 I ESCAPE Irn NEW LINE I RETURN I 

PF1 I ESCAPE IOJ TAB I TAB I .!:: 
PF2 I ESCAPE I [I) BACK TAB I CONTROL !-ill 
PF3 I ESCAPE 1m HOME I CONTROL I-m e: 
PF4 I ESCAPE I [IJ ATTN I CONTROL rill 
PF5 I ESCAPE I [[) SYS REQ I CONTROL I{[) e PF6 I ESCAPE Iw CURSR SEL I CONTROL I{Q] 

PF7 I ESCAPE I [I) CLEAR I CONTROL lill 
PF8 I ESCAPE I []] ERASE INPUT I CONTROL lill -PF9 I ESCAPE I (]] ERASE EOF I CONTROL KIJ 
PF10 I ESCAPE I []] PRINT I CONTROL HE] ~ 
PF11 I ESCAPE 10 IDENT I CONTROL I-{SZ] 

PF12 I ESCAPEIG TEST I CONTROL !-ill !:t 
PF13 I ESCAPEIOJ RESET I CONTROL HID 
PF14 I ESCAPE 100 DEV CNCL I CONTROL 1m .e; 
PF15 I ESCAPE 10 INSERT I CONTROL HI] 
PF16 I ESCAPE 10 DELETE ICONTROLf@ e: PF17 I ESCAPEI[JJ ENTER I ENTER I 

PF18 I ESCAPEI~ LEFT CURSOR G e: PF19 I ESCAPE II]] RIGHT CURSOR G 
PF20 I ESCAPE 10 UP CURSOR OJ 
PF21 iESCAPEIOJ DOWN CURSOR OJ e: 

!!: 
MacTerminal redefines two keys on the Macintosh keyboard to act as the 
Control and Escape keys. 

~ 

D o The Command key, located to the left of the space bar, is the Control key. e: 

[] o The key located in the upper -left corner of the keyboard is the Escape key. 
~ Note also that the Enter key on the Macintosh keyboard is the Enter key for 

a 3278 terminal. Press the Shift key and Enter for a long "break." (When 
~ MacTerminal is set to VT100 terminal type , the Enter key is the Break key.) 
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• The Macintosh 
Screen Display 

You use the Control key by holding down the key while pressing some other 
key. For instance, Control-U means to hold down the Control key while 
pressing U once. 

You use the Escape key by pressing the key and then pressing some other key. 
For instance, Escape-l means to press Escape once and then press 1 once. 

For your convenience, a copy of the table is printed on a tear-out card in the 
back of the AppleL ine User's Manual. You can remove the card and post it near 
your Macintosh for ready reference. 

When you're using your Macintosh to communicate with an IBM or IBM­
compatible mainframe, the screen display looks very much like the screen on 
an IBM 327S terminal and differs slightly from the usual MacTerminal display: 

o The main area of the screen presents data from the mainframe in the usual 
SO-column format; however, the main area is 24 lines long, and IBM's Status 
Information Area appears as the bottom line (line 25) of the MacTerminal 
display. 

o The appearance of the IBM status symbols on the status line will be different 
on MacTerminal. 

o The appearance of the IBM cursor may be different on MacTerminal. 

These differences mayor may not be apparent, depending on how the IBM 
program you're using is constructed. 
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To use the support available through the Status Information Area, open your 
AppleLine Supervisor document. Start up AppleLine and wait for the message 
to "Enter Password," Enter the current Supervisor password, Choose B on the 
menu ; you are going to modify the terminal type, On the set of options that 
appears, change the terminal settings to the ones shown in the illustration: 

D RppleLine Supervisor 

Your selection [Logoff and return to logon screenl: a 

Current terminal type is "MacTerminal" , 
Current BAUD RATE is "9500" , 
Current data PARITY is "Even" , 
AUTOBAUD is "Enabled", 
SPEED INDICATOR is "Disabled", 
Current MODEM type is "Local connect", 
Current AUTO LOGOFF is "Disab led", 
Special terminal capabi I ity is "25 I ine display", 
24/25 line automat i c togg lei s "0 i sab led" , 

Possible selections: 

A- Display terminal type and modem settings 
B- Modify terminal type and modem settings 
C- Change USER or SUPERVISOR passwords 
0- Logoff and hang up modem 
E- Logoff and return to logon screen 

Your selection [Logoff and return to logon screenl: 

Do you want to save the changes you have made [Yl ? y_ 

Once you 've made and saved these changes, close the AppleLine Supervisor 
document. You only need to change these settings once; from now on, you'll 
be able to use the support available through the 25th (or status) line, 
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Appendix 0 : 
Installing the 
Apple Cluster 
Controller 

• Direct Connection 

You 'll need the Apple Cluster Controller User's Manual: Part I-Reference to 
complete the hookup of the Macintosh. You can connect your Macintosh to the 
Apple Cluster Controller (ACC) directly or through a modem. 

To connect your Macintosh directly to the Apple Cluster Controller, you need a 
data cable with a pin-plug connector on either end- one to connect to a 9-pin 
socket and a larger one to connect to a 25-pin socket. 

1. Turn off the Macintosh and the Apple Cluster Controller. 

2. Attach the small connector on the data cable to the Modem port, marked 
with a symbol of a telephone, on the back of the Macintosh . . 

The Modem port is usually recommended for data communications. 
However, if you have a hard disk connected to the Modem port, connect 
your cable to the Printer port. 

3. Attach the large connector on the cable to one of the seven ports on the back 
of the Apple Cluster Controller. 

You can usually attach the cable from the Macintosh to any of these ports, but 
consult someone familiar with your Apple Cluster Controller configuration 
to determine the correct port. Some models reserve a port for other uses. 

§§L~\§§\ 

MaCintOSh--+-tI-~ ~o []~ 

\~ 
'=- / 

Modemport------+-----[~l 

Data cable Apple Cluster Controller 
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• Modem 
Connection 

To communicate with an IBM or IBM -compatible mainframe by a modem, 
you need a modem attached to your Macintosh and one attached to the 
Apple Cluster Controller. 

Refer to the Apple Cluster Controller User's Manual: Part I-Reference for 
instructions on installing a modem to the Apple Cluster Controller. 

DO 
Macintosh ------+-+1-

Modem port -----+----.....,~ 

Data cable Apple Personal Modem 
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• Setting Up 
MacTerminal 

The MacTerminal disk provides a document named Apple Cluster Controller 
that's preset to communicate between your Macintosh and the Apple Cluster 
Controller. If you use it and are directly connected to the Controller, you only 
need to make sure the baud rate matches the speed of the Apple Cluster 
Controller. If you're using a new MacTerminal document, be sure to set it up 
as described here. 

1. Choose Terminal from the Settings menu and set the Terminal options 
as follows . 

o Terminal Type- IBM 3278 

o Protocol Conv (Converter)- Cluster Controller 

o Online- On 

o Auto Repeat -On 

o Repeat Ctrls (Controls)- Off 

The following figure illustrates the preset options of the Terminal command. 

Terminal Settings 

Terminal a unDo allY @ IBM 3278 

Mode @!IN)1 a !m!2 

Cursor Shape @ Underline a Block 

line Width @nll [o !umns a ! 52 [ o!umns 

Protocol Conu a Appleline @ Cluster CUr 

I8l On line o t(1( II! !:(!w o S1<11u ~ Ugtlh 

I8l Auto Repeat o Hu1 (l Wl'<lp<ll'ound D Npw Line 

o Repeat Ctrls D lmnsp<ll'(m1 0 (cancel) 
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2. Choose Compatibility from the Settings menu and set the Compatibility 
options as follows: 

o Choose the baud rate that matches the baud rate of the Cluster Controller. 

o Bits per Character -7 Bits 

o Parity-Even 

o Handshake-X On/ X Off 

o Connection-Modem or Another Computer, depending on how your 
Macintosh is connected to the Apple Cluster Controller 

o Connection Port-Modem port (or Printer port, although it's not 
recommended) 

The preset options of the Compatibility command are shown in the following 
figure. 

Compatibility Settings 

Baud Rilte 050 075 0110 0134.5 

0150 0200 0300 0600 

01200 01800 02000 02400 

03600 04800 @9600 019200 

Bits per Character @ 7 Bits 08 Bits 

Pilrity @ Euen 0 Odd ONone 

Hilndshilke @ HOn/HOff 0 None 

Connection 0 Modem @ Another Computer 

Connection Port @ I~I 0 181 ~ r.::=::.I 
~~ 
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AppendixE: 
MacTerminal as a 
DEC VT100 

MacTerminal implements all of the features of the DEC VT100 terminal with 
AVO (Advanced Video Options, such as boldfacing and inverse characters) 
except the following: 

o margin bell 

o key click 

o smooth scroll 

o blinking character attribute 

o remote diagnostic (loopback) text mode 

o dark screen background as the normal text display mode 
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E: Appendix F: ASCII 
Key Code Code Abbrev. Name Control 

(Dec) (Hex) I!!: Characters 
ICONTROL~ 00 $00 NUL Null 

!:: I CONTROL f-0 01 $01 SOH Start of Header 
I CONTROL f[[] 02 $02 STX Start of Text 
I CONTROL f-[IJ 03 $03 ETX End of Text !:: 
I CONTROL].@] 04 $04 EOT End of Transmission 
I CONTROL J.ill 05 $05 ENQ Enquiry 
I CONTROL f.lIJ 06 $06 ACK Acknowledgment 
ICONTROL f@ 07 $07 BEL Bell 
CONTROL f.[ill 08 $08 BS Backspace 
CONTROL fill 09 $09 HT Horizontal Tab !:: CONTROL ~ 10 $OA LF Line Feed 
CONTROL I-[K] 11 $OB VT Vertical Tab !!: CONTROL fill 12 $OC FF Form Feed 
CONTROLf@ 13 $00 CR Carriage Return 

!:: CONTROL f-Cill 14 $OE SO Shift Out 
CONTROL f.[Q] 15 $OF SI Shift In 

I CONTROL 1-0 16 $10 OLE Data Link Escape !:: 
I CONTROL f.@] 17 $11 DC1 (XOn) Device Control 1 
ICONTROL~ 18 $12 DC2 Device Control 2 !!: 
I CONTROL f-rn 19 $13 DC3 (X Off) Device Control 3 
I CONTROL fill 20 $14 DC4 Device Control 4 !!: 
I CONTROL f.{]] 21 $15 NAK Negative Acknowledgment 
I CONTROL fffi 22 $16 SYN Synchronization Character !!: ICONTROL~ 23 $17 ETB End-of-Transmission Block 
I CONTROL fill 24 $18 CAN Cancel 

~ I CONTROL f-(Y] 25 $19 EM End of Message 
I CONTROL fill 26 $1A SUB Substitute 
I CONTROL I-!Il 27 $1B ESC Escape !:: 
I CONTROL fill 28 $1C FS Forms Separator 
I CONTROL I-!Il 29 $10 GS Group Separator !!:: 
I CONTROL fIT) 30 $1E RS Record Separator 
I CONTROL f.(Z] 31 $1F US Unit Separator ~ 
ICONTROLf@ 127 $7F DEL Delete 

!:: 

e: 
~ 

!!: 
!:: 

!:t 

~ 
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Appendix G: Pin 
Assignments for 
the Apple Modem 
OataCable 

Pin Meaning 

1 Cold (Chassis) Ground. 

2 +5 Volts Filtered. (Do not draw current from this pin.) 

3 Cold (Chassis) Ground. Can be used for signal ground. 

4 Transmit Data Plus. 

5 Transmit Data Minus. 

6 + 12 Volts Filtered. (Do not draw current from this pin.) 

7 Handshake Input. (Goes to Plus side of a receiver whose Minus side is 
grounded for reference.) 

8 Receive Data Plus. 

9 Receive Data Minus. 
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Glossary access telephone number E: 
The telephone number of the other computer. You enter this number in the 

~ Phone Settings dialog box from the Phone menu and you have MacTerminal 
dial it with the Dial command. !::: 
ANSI 
Acronym for American National Standards Institute, which sets standards for 
many technical fields, including computer terminals. Normally, the VTl 00 
follows these standards-unless it has to imitate the older VT52 terminal. 
When you select VTl 00 in the Terminal Settings dialog box, you get to choose 
which mode you want-ANSIorVT52. The IBM 3278 follows ANSI standards, 
but does not offer you the abi lity to imitate the VT52 . 

Answerback 
A Setting that allows you to set up a message identifying MacTerminal to 
another computer. The message depends on what the other computer e: 
requires. The message lets the other computer know that contact has been 
established. !!: 
Apple menu !!: The menu on the far left in the menu bar, from which you choose desk 
accessories. Its title is an apple symbol. !:: 
application 
A computer program that puts the resources of the computer to use for some 
specific purpose, such as word processing or telecommunications. 

~ 
ASCII 
Acronym for American Standard Code for Information Interchange, !:: 
pronounced ASK ee. A code in which the numbers from 0 to 127 stand for 

!:: text characters-including the letters of the alphabet, the digits 0 through 9, 
punctuation marks, special characters, and control characters. Used for !":: representing text inside the computer and for transmitting text between 
computers. The Text and XModem Text protocols transfer files consisting 

~ only of ASCII characters; such files are also known as textfiles. 

AutoRepeat e: 
An option that automatically repeats a character for as long as you hold down 

~ the key. You can make this possible, or stop it, by using the Terminal command 
on the Settings menu. e: 

e: 
!:: 

!: 
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Auto Wraparound 
An option on Terminal Settings, telling MacTerminal that when text reaches 
the last column, it should spill over into the next line. Otherwise, the cursor 
stops at the last column, and every new character overwrites the last. You can 
also have MacTerminal break lines after a word-rather than within a word­
when you send out text; on File Transfer Settings, check Word Wrap Outgoing 
Text. 

Backspace key 
A key that moves the cursor back one space. Using the Keyboard command on 
the Settings menu, you can decide whether pressing the Backspace key will 
move you back one character, or delete that character. 

baud rate 
The speed at which your data is being transmitted. The baud rate is equal to the 
number of discrete signals per second. Rough rule of thumb: divide the baud 
rate by ten to find out the characters-per-second. 

Break key 
In MacTerminal, the Enter key functions as the Break key when pressed at the 
same time as the Option key. Press Option-Enter to send a break. Press Shift­
Enter to send a long break. 

Calculator 
A desk accessory that works like a four -function pocket calculator. Calculation 
results can be cut and pasted into the terminal display. 

Cancel button 
A button that appears in dialog boxes. Clicking this button cancels the 
command. 

carrier 
The signal on a communication channel. It is modified to carry the 
information. If you get the message ' 'No carrier," it means that you are not 
connected with the other computer. 

character set 
The entire collection of characters that can be shown on the screen or used to 
code computer instructions. MacTerminal has 14 character sets from which 
to choose a primary character set - the one that is usually displayed-and an 
alternative set. On the Settings menu, choose Character Sets to specify which 
one you want to be currently active. 
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Christensen protocol 
Ward Christensen developed the XModem protocol, an agreement between 
two computers about how they'll exchange data. This method sends data and 
keeps on sending it until it gets there. It does not give up when it discovers an 
error; it resends the correct version. 

Clear Lines Off Top 
Tells MacTerminal to erase everything it has recorded above the dotted line, 
when MacTerminal is recording information as the lines roll off the top of your 
screen. Commands menu. 

click 
To position the pointer on something, and then press and quickly release the 
mouse button. 

Clipboard 
The holding place for what you last cut or copied. Maximum size: 32,000 
characters, or approximately 16 pages of single-spaced text. 

close box 
The small white box on the left side in the title bar of an active window. 
Clicking a close box closes the window and removes the window from 
the desktop. 

command 
A word or phrase, usually in a menu, describing an action for the Macintosh 
to perform. Choosing a command causes the action to take place . Some 
commands have an equivalent keyboard combination of the Command key 
and a character key that accomplishes the same thing. 

Command key 
See Control key. The Command key does not have its normal function while 
using MacTerminal. 

communications session 
The activity during the time you are connected to the other computer and 
accessible by the other computer. You make a connection to the other 
computer by a direct cable or by a modem and telephone lines. 

compatibility 
The ability of one computer to get along with another. On the Settings menu, 
the Compatibility command allows you to control the speed, format, error­
checking, and physical connections used in sending or receiving data between 
computers. 

Glossary 
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The physical link between your Macintosh and the other computer. You can 
link them directly or through modems. If you connect to the other computer by 
telephone, you attach your Macintosh to a device called a modem, which sends 
data from MacTerminal over the telephone lines to another modem at the other 
end, which in turn sends the data on to the other computer. When you use a 
special cable to attach your Macintosh directly to an IBM mainframe and you 
want your Macintosh to emulate an IBM 3278 terminal, the Apple Cluster 
Controller or the Apple Line acts as an intermediary. 

connect time 
The elapsed time between the moment MacTerminal makes contact with 
another computer, starting a communications session, and the moment when 
you terminate the connection. 

control character 
An ASCII character used as a command to a computer, terminal, or printer. 
See Control key. 

Control key 
In MacTerminal, the Command key functions as the Control key-a key that 
when pressed with another key issues a command. When you type H, the 
computer considers it just another letter in the alphabet, but when you press 
CONTROL-H the computer considers it a command. 

Control Panel 
A desk accessory that lets you change the speaker volume, the keyboard repeat 
speed, and other preferences. 

cursor 
A blinking underline (or solid rectangle) that marks the position of the next 
incoming or outgoing character shown in the terminal display area. 

cursor key 
A key on the numeric keypad that can function as a cursor key when you've 
chosen a VTl 00 terminal type. Cursor keys move the cursor vertically or 
horizontally in the terminal display area and may be needed to use the 
application on the host computer. 
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cut 
To remove something from a desk accessory by selecting it and choosing Cut 
from the Edit menu, which places the selection on the Clipboard. Data in 
a MacTerminal document can be copied but not cut. 

data 
Information, especially information used or operated on by a program. 
Characters that convey meaningful text or graphics. Distinguished from 
arrangement (for instance, characters that announce that the information 
is about to start, or has just stopped) or error-checking (for instance, 
characters that are put in to help make sure that there have been no mistakes 
in transmission). 

delay 
A deliberate slowing down, as when you add a time interval between characters 
or between lines while you send them. Sometimes the other computer cannot 
receive information as fast as MacTerminal sends it, and no adjustment of the 
baud rate helps. In this case, you can go to the Settings menu and choose File 
Transfer to tell MacTerminal to insert a one-second delay between lines or 
characters, increasing the delay gradually until the other computer can read 
you. 

desk accessories 
"Mini-applications" that are available from the Apple menu regardless of 
which application you 're using. Examples are the Calculator, Note Pad, 
Alarm Clock, and Puzzle. 

desktop 
Macintosh's working environment-the menu bar and the gray area on the 
screen. 

Dial 
Acommand on the Phone menu telling MacTerminal to dial the phone number 
you entered into Phone Settings. 

dialog box 
A box that contains a message requesting more information from you. A dialog 
box has places to enter information and choose options. 

dimmed command 
A command that appears lighter and grayer than other commands in the menu. 
When a command is dimmed, it cannot be chosen. 
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dimmed icon 
An icon that represents a disk-or a document, folder, or application on a 
disk- that has been ejected. Any dimmed icon can be selected. Dimmed disks 
and folders can be opened; dimmed documents and applications can't be. 

DIP switch 
A bank of tiny switches, each of which can he moved manually one way 
or the other to represent one of two values (usually on and off). DIP stands for 
dual in-line package. 

disk 
The magnetic medium on which the Macintosh stores information. 

disk drive 
The mechanism that holds the disk, retrieves information from it, and saves 
information on it. Macintosh has an internal disk drive, and you can add an 
external one, or a hard disk. 

document 
Whatever you create with Macintosh applications-information you enter, 
modify, view, or save. In MacTerminal, a document provides the options for 
setting up a communications session and the display area to view incoming and 
outgoing data . A document can also contain data that you 've instructed 
MacTerminal to record and save. 

double-click 
To position the pointer where you want an action to take place, and then press 
and release the mouse button twice in quick succession without moving the 
mouse. 

drag 
To position the pointer on something, press and hold the mouse button, move 
the mouse, and release the mouse button. When you release the mouse button, 
you either confirm a selection or move an object to a new location. 

EBCDIC 
Acronym for Extended Binary Coded Decimal Information Code. 
(Pronounced EB-si-dik.) An IBM code that represents each letter, number, 
special character, and control character as an 8-bit binary number. EBCDIC 
has a character set of 256 8-bit characters. 

echo 
For a host computer to retransmit every character it receives back to the 
terminal that sent it. Most computers use echo to confirm the connection 
continually. 

Glossary 127 



128 

E: 

emulator E: 
Imitator. MacTerminal is an application that can emulate several different 
terminals; it is a terminal emulator. !!: 
Enter key 
A key that confirms or terminates an entry or sometimes a command. In VTl 00 
emulation, the Macintosh Enter key is eqUivalent to the Break key. In IBM 3278 
emulation, the Macintosh Enter key is eqUivalent to IBM's Enter key. 

error message 
A message from the computer indicating that a function , command, or entry 
cannot be performed or accepted. Error messages are often accompanied by 
a beep. 

Escape key 
In MacTerminal, the Escape key is the accent/tilde key at the upper-left corner 
of the keyboard. 

escape sequence 
A sequence of keystrokes beginning with the Escape key, often used for 
positioning the cursor and controlling the display of text on the screen. 

file 
A collection of information stored on a disk; usually a document. Macintosh 
files include documents, system files, and text files . 

File Transfer 
A command on the Settings menu that allows you to specify what file transfer 
protocol you want to use , how you want to save information that comes across 
your screen, and how you want to send out information. Transferring a file 
involves sending it from one computer to another. A File Transfer protocol 
establishes the way each computer will send and receive that file . MacTerminal 
offers several File Transfer protocols. Between Macintoshes, use 
MacTerminall.l. Between your Macintosh and most information services, use 
Mac Binary. When communicating with an IBM mainframe, or a computer that 
can handle only sequences of ASCII characters (text files) , use Text. 

Finder 
An application that's always available on the desktop. You use it to manage 
documents and applications and to gain access to the contents of disks. 

font 
A collection of letters, numbers, punctuation marks, and other typographical 
symbols with a consistent appearance. The font used by MacTerminal is 
Monaco. 

Glossary 



-~ 
~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

font size 
The size of characters in text. The Monaco font in MacTerminal is 9 pOint. 
There are 72 points to an inch, so the font is an eighth of an inch high, from the 
top of a capital Tto the bottom loop of a lowercase g. 

format 
The arrangement of text as determined by the margins, tabs, line spacing, 
and text alignment. 

full duplex 
A communications link capable of simultaneous two-way transmission; allows 
the other computer to echo received characters back to MacTerminal's display. 

function key 
A key that performs special functions usually determined by the application 
of the other computer. Function keys for the VTl 00 and the IBM 3278 appear 
on MacTerminal's Keypad menu. 

half-duplex 
A communications link between the host computer and MacTerminal in which 
only one device can transmit at a time, as with walkie-talkies. The host 
computer cannot echo what you send, so your screen appears blank until you 
choose Terminal on the Settings menu, and check Local Echo. 

handshake 
A protocol for devices to exchange information about the communications 
connection itself, such as when to start and stop transmitting. MacTerminal 
uses the X On/ X Off handshake method. 

hard disk drive 
A device that holds a hard disk, retrieves information from it, and saves 
information to it. A hard disk can store much more information than a 3.5 inch 
single- or double-sided disk. 

hide 
To remove from the display. On the Edit menu, you can choose Show 
Clipboard, then Hide Clipboard; similarly, on the Settings menu, you can 
choose Show Tab Ruler, then Hide Tab Ruler. 

highlight 
To make something visually distinct from its background. An item is usually 
highlighted to show that it has been selected or chosen. 
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host computer 
A computer that manages information for many terminals. A host computer 
may be a mainframe, minicomputer, or another microcomputer. 
(The microcomputer might be running an electronic bulletin board, 
for example.) 

icon 
A graphic representation of an object, a concept, or a message. 

initialize 
To prepare a disk to receive information. 

insertion point 
The spot where something will be added. An insertion point is selected 
by clicking and is represented by a blinking vertical bar. In MacTerminal, 
insertion points appear only in dialog boxes where you 're asked to type 
information. 

Key Caps 
A desk accessory that shows you foreign characters and special symbols. 

Keypad menu 
Provides you with the on -screen equivalent of the Macintosh numeric keypad, 
imitating the function and cursor keys of the VTl 00, or the function keys of 
the IBM 3278, depending on which terminal you checked (Settings menu: 
Terminal). You can' 'press" a key by chOOSing it from the open menu. 

line feed 
An ASCII character (decimal 1 0) that ordinarily causes the cursor to drop 
down to the next line- in the same column it was in before. MacWrite does not 
normally put a line feed at the end of each line, but the other computer may 
need line feeds. If it does, you can set MacTerminal to insert a line feed at the 
end of each line, to break the lines at the right spot. When New Line is checked 
on the Terminal settings, and you are sending text, MacTerminal adds a line 
feed after every Return. The cursor drops to the next line and then zips back to 
the beginning of that line. If you are receiving data and it all ends up on one 
line, check New Line on the Terminal settings; MacTerminal will then act on 
any line feed it receives. 

local echo 
A method of communication in which MacTerminal displays data "locally" in 
the terminal display area as you send it, without relying on the host computer to 
echo the characters back. 
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log off 
To type a command to the host computer that terminates the communications 
session. 

logon 
To enter a series of responses to prompts by the host computer, at the 
beginning of a communications session, to identify yourself, your account 
number, sometimes your terminal , and so forth. 

mainframe computer 
A large computer whose speed and storage capacity allow it to handle huge 
amounts of data and work with many terminals. 

menu 
A list of commands that appears when you point to and press the menu title in 
the menu bar. Dragging through the menu and releasing the mouse button 
while a menu item is highlighted chooses that item. 

menu bar 
The horizontal strip at the top of the screen that contains menu titles. 

mode 
In MacTerminal , one of two ways a VT1 00 terminal behaves: it can be in its 
standard mode, as defined by the American National Standards Institute 
(ANSI mode), or it can imitate an earlier terminal , the VT52 (VT52 mode). 
You set the mode in the Terminal Settings dialog box. 

modem 
Short for MOdulator/ DEModulator. A peripheral device that links your 
Macintosh with other computers and information services via telephone lines. 

NotePad 
A desk accessory that allows you to enter and edit small amounts of text while 
working in a MacTerminal document. 

numeric keypad 
A set of keys arranged as on a calculator, for rapid entry of numbers. There is 
a physical keypad-it may be part of your regular keyboard, or an accessory 
unit -and an on-screen equivalent. If you do not have the physical keypad, you 
can pull down the Keypad menu and choose keys the way you would menu 
items. With the VT100 or IBM 3278 terminal types, the keys on the numeric 
keypad take on special functions defined by the applications running on the 
other computer. 
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off-line 
Describes equipment and activities connected to but not accessible by the 
other computer because you've temporarily interrupted (without terminating) 
your session to do something else. 

on-line 
Currently connected to and under the control of the host computer. When 
MacTerminal is on -line to the host computer, the host computer defines much 
of what you can do. 

open 
To create a window so you can view the contents of a disk, document, or text 
file . 

Option key 
A key used like the Shift key to give an alternate interpretation to another key 
you type. 

parallel transmission 
A way of transmitting data, in which several bits of information (typically eight 
bits or one byte) are transmitted simultaneously over several different wires or 
channels. 

parameter 
A variable that determines the outcome of a command by setting limits, rates, 
or levels. You set many communications parameters by choosing commands 
on the Settings menu. For instance, in establishing the speed of transmission, 
or baud rate, 1200 is a common parameter. 

parity 
A method of detecting errors in data transmission. The computer that sends a 
piece of data adds a bit, and the receiving computer looks at that bit to make 
sure that it maintains a sameness ( or parity) of level or count. If not, the 
assumption is that an error has been made somewhere along the line. There are 
several kinds of parity, and when you find out what the other computer expects, 
you can set MacTerminal to perform the same operation; on the Settings menu, 
choose Compatibility. Because they have better quality telephone lines, some 
host computers do not need to set up any form of parity. 

paste 
To place the contents of the Clipboard-whatever was last cut or copied-into 
a document, text file, or desk accessory. Pasting into a MacTerminal document 
during a communications session sends the data to the remote computer. 
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port 
The connection sockets on many peripheral devices through which data is 
transmitted. The Macintosh Modem port is the only one recommended for 
both sending and receiving data. The Printer port may not receive data 
accurately if you send it at speeds over 1200 baud. 

Print Selection 
A File command, telling MacTerminal to print what you have selected in the 
document. A dialog box appears, allowing you to adjust quality, page range, 
number of copies, and type of paper. 

prompt 
A query or advisory message from a host computer to the terminal user, such as 
a request to type a password or choose a command. 

protocol 
A set of rules for sending and receiving data on a communications line. Devices 
such as the Apple Cluster Controller and AppleLine convert data from one 
protocol to another; they are known as protocol converters. 

Receive File 
A command that prepares MacTerminal to receive a file. If you have chosen 
MacBinary, XModem Text, or Straight XModem as the protocol (Settings 
menu: File Transfer), and are about to receive a file , choose this command 
on the File menu. 

Record Lines Off Top 
To save lines as they scroll off the top of your screen, and put them in your 
document on disk. Choose this on the Commands menu; when you choose it, 
the command changes to "Don't Record Lines Off Top," so you can stop the 
process. Must be on to use Save Screens Off Top (Settings menu: File 
Transfer). 

Save 
To transfer information from your Macintosh to a disk, for storage. 

Scrapbook 
A desk accessory in which you can save frequently used pictures or passages 
of text. 

scroll 
To move information in a window so that a different part of it is visible. 
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scroll area 
The region, defined by a host computer, above which lines of data move out of 
your view. The scroll area is usually the entire terminal display area but may be 
a smaller region within it. 

scroll arrow 
An arrow on either end of a scroll bar. Clicking a scroll arrow moves the 
document or directory one line. Pressing a scroll arrow scrolls the document 
continuously. 

scroll bar 
A rectangular bar that may be along the right or bottom of a window. Clicking 
or dragging in the scroll bar causes the view of the document to change. 

scroll box 
The white box in a scroll bar. The position of the scroll box in the scroll bar 
indicates the position of what 's in the window relative to the entire document. 

select 
To designate where the next action will take place. To select, you click, double­
click, or drag across information. In MacTerminal, you can select data to copy it 
to another application. The selection is usually highlighted. 

send 
To transfer information. Once you have started a communication session, 
you can Paste information into your document; that information will be sent 
automatically to the other computer. To send a whole file , choose Send File 
on the File menu. 

serial port 
A socket on the back of the Macintosh that allows you to connect it to serial 
communications devices-modems, printers, other computers, and so forth . 

serial transmission 
A way of transmitting data, in which one bit is sent at a time, sequentially, over a 
single wire or channel. Serial cables plug into serial ports. On the MaCintosh, 
the serial ports are the Modem port and the Printer port. 

Shift-click 
A technique that allows you to extend or shrink a selection by holding down 
the Shift key while you revise your selection. 

Shift key 
A key that, when you hold it down, causes subsequently typed letters to appear 
in uppercase and causes the upper symbol to appear when you press number or 
symbol keys. 
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size box 
A box on the bottom right of some active windows that lets you control the size 
of the window. 

software 
Programs, or instructions for the Macintosh to carry out. The Macintosh reads 
these instructions from disks inserted into the disk drive. 

startup disk 
A disk with all the files you need to use the Finder and possibly one or more 
applications. 

status lights 
Some terminals, such as the VT100, have a series of lights that report on the 
condition of the terminal and the program running on the host computer. One 
shows whether you are on-line or not, another whether the keyboard is locked. 
The meaning of others depends on the program you are using on the host 
computer. You can have MacTerminal simulate these status lights by going to 
the Settings menu, choosing Terminal, picking VT1 00, and then checking 
Status Lights. 

status line 
The IBM Status Information Area that appears on the 25th line of a 
MacTerminal display when you are emulating an IBM 3278 terminal through 
the AppleLine. Gives you information about your 3278 session. 

system file 
Any of the files normally found in the System Folder. 

tab marker 
A filled diamond on the tab ruler, indicating the position to which pressing the 
Tab key will move the insertion point. 

tab ruler 
A ruler in MacTerminal that lets you change tabs for incoming tables that 
contain tab stops. 

terminal 
A device that lets you communicate with a host computer through a keypad and 
display or printer. 

terminal emulator 
An application used to make a personal computer act like a terminal to a host 
computer. The application usually emulates (mimics) a certain popular brand 
of terminal; MacTerminal emulates the DEC VT1 00 and the IBM 3278, as well 
as a TTY, the standard teletype-like terminal. 
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text 
Information in the form of characters readable by human beings. A text file is 
encoded using the ASCII format. You can create text files in most applications; 
for instance, from MacWrite, choose Save As, and check Text Only, then save. 
You can transfer a text file by the Text or XModem Text protocols. 

title bar 
The horizontal bar at the top of a window that shows the name of the window's 
contents and lets you move the window. 

transfer 
To send or receive information between computers. 

transmit 
To send information to the other computer. 

TTY 
Stands for Teletypewriter, a Teletype terminal that ignores many of the 
commands from the remote computer that the VT100 or IBM 3278 can 
respond to. The TTY responds to Return, Tab, Backspace, and Line Feed 
characters, ignoring other control characters and all escape sequences. 

window 
The area that displays information on a desktop. You view documents through 
windows. You can open or close windows, change their size, edit their 
contents, scroll through them, and move them around on the desktop. 

XModemText 
The File Transfer protocol to use for sending plain text (ASCII characters 
without font or format information) from your Macintosh to another type of 
computer-if that computer supports the XModem protocols. More reliable 
than the Text protocol. 

XOn/XOff 
A handshake protocol (transmit-On/ transmit-OfD used by computers and 
intelligent terminals to control the flow of data between the systems so that one 
system isn't overloaded. 
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Index 

A 
About MacTerminal command 53 
access number 9,17,31,32,82,122 

format 31,82 
entering 16,82, 106 

account number, logging on 18 
Advanced Video Options, VTl 00 terminal 119 
alternate character set 78 
alternate keys, use of 20 
Alternate ROM Graphics character set 79 
ANSI mode setting 66, 122 
Answerback message 18,77, 122 
answering incoming calls 18 
Apple Cluster Controller 5,30,67,104 

document 117 
installing 115-18 

Apple Hard Disk 20 30,35,73,88 
AppleLine 103 

Controller device 5 
document 30,104 
installing 101-14 
protocol converter setting 67 
Supervisor document 30, 106-09 
supervisor program 106-09 

Apple menu commands 52-53 
Apple Modem 5,16,31,81,83,86,103,116 See also modem 

during transmission 18 
ending transmission 25 
originating calls through 32 
receiving calls through 32,87 

Apple Personal Modem 5,87,103, 116 
AppleTalk modem connections 100 
Apple II 34 
applications 122 

opening MacTerminal document with 42 
sending applications file 38 
using on host 21, 24 

arrow keys 84,96-99 
ASCII 122 

characters, in transfer 15,76 
control characters, list of 120 
files 13, 76 

audible signals 18 
autobaud message 106 
Auto Link 212A 5 

Index 

Auto Repeat setting 11,69, 122 See also Repeat Ctrls setting 
Auto Wraparound setting 11,12,30,36,37,69,123 

B 
Backspace key 123 

setting 20,70,79 
baud rate 9,10, 11 , 14,30,32,71,73,106,117, 123 

setting for modem 16, 38, 71 
Baud Rate setting 30,70,72, 104 
bits per character 10,71 
Bits per Character setting 30,70 
bits per second 10,71 
blank page icon 23 
blinking character VT100 attribute 119 
Block cursor shape setting 66-67 
Boich, Mike 53 
bps See bits per second 
Breakkey 123 

in log-on sequence 20,95,98 
bytes, in relation to file size 47 

C 
cable assembly, for AppleLine 102 
Calculator 123 
Cancel button 30,123 
Caps Lock key 11 0 
capturing screen information 22 
carrier 123 
changing disks See disk 
characters 

free on disk 53 
stored off top 53 

character set 78-79, 123 
Character Sets command 78-79 
Christensen, Ward 15,76 
Clear command 63 
Clear Lines Off Top command 21,64,124 
Clipboard 22,24,36,37,43,63, 124 
Close file command 45,55 
Cluster Ctir protocol converter setting 67 
columns 

in tables, and copying 43,62,80 
of characters 66,67 See also Line Width setting 

Command key 20,33,35,70,79,85,86,95-99, 111, 112-13, 
124 See also Control key 

Commands menu 21,63 
Commercial Services document 9,30,88 
communicating 

by cable See connection 
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with host computer See host computer 
with personal computer 21,40,63, 74 

common settings 40 
connecting to 18 
settings for 30,40,65-80 
with another Macintosh 34, 38, 76 
with Apple II 34 

communication networks 40 
communications parameters 3,8,10,11,70,106 
communications problems See transmission problems 
communications session 4,21,24, 63,64, 124 

basic steps 6, 109 
clearing settings 64 
ending 25,43,57 
pasting during 22 
preparing for 31 ,33,65-80 
saving 14 
starting 17,32,35 
template document for 88 
temporarily suspending 67 

compatibility 124 
Compatibility settings 10, 11,30,32,38,40,65,70,105 
CompuServe iv, 9, 15 
computer, host See host computer 
computer, personal See communicating with personal 

computer 
computer terminal 3 
configuration of hardware 88 
connection 4,10,32,70,125 

direct 5,30,32,38,39,70,71,72,102,105 
makinga 18,39,41 
over phone lines 39 

static 89 
setting 72 
sounds 18,32 
temporarily suspending 67 
terminating 25,43 
through modem See modem 
with host computer 18, 21 ,33,65-80 
with personal computer 18,21,33,74 

Connection Port setting 10,32,70,72 
connect time 4,25,125 
control characters 33,70,77,125 
Control keys 95-99,112-13,125 See also Command key 

terminal commands 65,77 
used in log-on 20,33 

Control Panel 69,125 
copying 
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documents and applications to other disks 47 
MacTerminal data to other documents 42 

Index 

onto Clipboard 22,43 
paragraphs 43 
selecting data to copy 22,43 
tables 43,62 

Copy and Paste commands 8,22,43,62-63 
Copy Table command 43,62,80 
creating a MacTerminal document 8 
Currently Active setting 78 
cursor 8, 113, 125 
cursor keys, in full-screen applications 86,96,99,125 
Cursor Shape setting 11,66-67 
Cut command 8,62,126 

D 
data cable 102, 103, 115-116 

pin assignments 121 
DEC VT100 3,11,12,24,40,65,66,67,79 

full-screen applications 86 
Control key commands 20, 65 
features not implemented 119 
keyboard keys 83-84,95-99 
Status Lights 11,65,67 

delay 126 
Delay Between Chars setting 13,37,73-74, 86 
Delay Between Lines setting 13,37,73-74 
delete, using Backspace 20, 79 
deleting recorded data 21 
desk accessories 8,53,63, 122,123,126 

cutting from and pasting into 22,24,36, 123 
Desk Accessories command 53 
Dial command 32,81, 126 
DIALOG iv 
dialog box 126 
Dial Phone setting 31 , 82 
dial tone 82 
dimmed menu commands and options 58,63,65,66,70, 

81 , 126 
direct connection See connection 
disk 127 

changing disks 46 
ejecting a disk 46, 56 
hard disk See hard disk 
space available on 47,53,64 

disk drives, saving on 46 
disk full message 14 
display See also screen display 

area of terminal screen 8, 22,37,57,64,67,113 
problems with 40 

incoming data 65 
problems with See transmission problems 
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status line on IBM terminal 113-14 
with full screen host applications 86,113 

document 9, 127 
MacTerminal 7,8,9 
opening 8 
preset on program disk 

Commercial Services 9 
HardDisk 9 
Macintosh 9 

size of, in relation to disk space 47 
Don't Record Lines Off Top command 21,31,63-64 
Dow Jones News/ Retrieval iv, 9, 17 
drag 127 
dragging icons, to copy files 47 
Drive button, in dialog box 54,56,57 
duplex signal transmission 10 See also full duplex and 

half duplex 

E 
echo 127 

local See Local Echo setting 
echo back 19,37 
Edit menu commands 62-63 
Eject button, in dialog box 54,56, 57 
ejecting a disk 46, 56 
Empty Trash command 47 
emulating See IBM 3278 and DEC VT100 
emulator 128 
enable XOn/ XOff 10 
ending a session See communications session 
Enterkey 20,95,98,112,128 
equipment 5 
errors in transfer 15, 76 
Escape key 20,112-13,128 
escape sequence 128 
even parity 10,70 See also parity 
Excel , copying tables to 80 
exiting MacTerminal 43 
External Disk drive port 73,88 

F 
features, setting 11 
File Menu 54 
files 128 

application, sending 38 
new document 22 
on other disks 35 
opening 23 
system, sending 38 
type 13,57 

Index 

File Transfer 128 See also transfer methods 
and types offiles 57 
command 22,23,34 
Protocol 13,14,24, 32,58,76 
settings 13,14,31,34,41, 73-74 

when receiving from mainframe 42 
Finder 22,45,61,128 

new file in 42 
font 128 
foreign-language character sets 36,78-79 
format 129 
formatting, retained in transfer 15 
full duplex 10,68,129 
full screen applications 86 
function keys 83-84,86,96-99,110-11,129 

G 
GO 78 
G1 78 
gauge, showing progress of transfer 22,35,42, 57 
gender changer 102, 103 
Get Info file command 47 
Graphics character set 78 
grave key equivalent 20,95 

H 
Haeberli, Martin 53 
half duplex 10,68,129 
handshake 10, 129 
Handshake compatibility setting 30,65,70,71 
Hang Up command 25,43,81 
hard disk 30,73,88,129 

connected to different ports 88 
Hard Disk document 8,9,30,88 
Hard Disk 20 See Apple Hard Disk 20 
hardware setup 88 
Hayes Smartmodem 5,87 
heirarchical filing system 35 
Hide Clipboard command 63 
Hide Tab Ruler command 80 
hookup See specific device name(s) 
host computer 3,18,19,130 

commands from 64,65 
communicating with 21,33,63,75,77 

settings for 30,65-80 
logging off 25 
logging on 18,32,33 
using applications 24,86 

139 



I 
IBM 4,11 

communicating with 30,103,116 
status line and symbols 113 
system and AppleLine connection 101-14 

IBM3278 3,4, 11 , 12,67,104,109 
and transfer 15,76 
emulating 9,11,34,66,76, 128 

screen display 113 
equivalent keys 20, 110-13 
function keys 83,110-11 
Keyboard Equivalents Table 112 
programmable keys 97,99,110-12 
terminal emulation setting 66,104 

icon 130 
blank page 23 

ImageWriter printer 44 
incoming calls 18,31,58 
incoming data 

display of 65,69 
problems with See transmission problems 

incoming files See receiving files 
information services 9, 11 

communicating with 30,71 
transferring files to and from 15, 34 

initialize 130 
insertion point 130 
insert mode 33 
intelligent modems 87 

J, K 
K See kilobytes 
Kbd locked indicator 65,68 
keyboard, locked 65,68 
keyboard characters 36 
Keyboard command 20 
Keyboard Configuration command See Backspace key 
Key Caps desk accessory 78 130 
key click VT1 00 feature 119 
key equivalents 20,95-99,110-13 
Keypad 86,99,110 
keypad layouts 83-84,99 
Keypad menu 68,83-84,99,130 
kilobytes, in relation to file size 47 

L 
line breaks 37,74 
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and Return characters 23,69 
setting 14, 34 

Index 

!inefeed 130 
in transfer 15, 69 

Line Width setting 11 ,66-67,74 
Lisa 2/5 or 2/10 iv 
Local Echo setting 10,11,12,30,35,36,37,57,63,68, 

129, 130 
locked keyboard See keyboard, locked 
logging on 6,18, 19 

to a host computer 18, 31 
log-off 25,109,131 
log-on 20,33,109,131 
lowercase letters 110 

M 
Mac Binary transfer method 15,18,24,32,34,76 
Macintosh iv, v, 5,30 
Macintosh document 9,30,76 
Macintoshfile 13,57 

transferring 15,38,76 
Macintosh keyboard 20,95-99,110-13 
Macintosh Plus iv, 35 

keyboard 95-99 
Macintosh XL iv, 3, 5, 30, 38 
MacTerminal 3, 107 

commands 52-85 
program and current session information 53 
quitting 43 
starting 7 
using with a hard disk 88 

MacTerminall.1 transfer method 9,15,24,30,34,38,76 
MacTerminal document 6,8,32,35,40,109 

closing 55,61 
opening 45 
preset documents 30 
setting up 30 

MacWorks XL iv, 3 
MacWrite 

and ASCII files 13 
!ine breaks 23,75 

mainframe 4,131 
applications 22 
communicating with 30,65-80,103,116 
multilingual See Character Sets command 
receiving files from 42,64,75 
screen display 113 
transferring files to 15 

margin bell VT100 feature 119 
mark parity 71 
MCl Mail iv, 30, 40 

and handshake 71 
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menu bar 8,131 
menu commands, using 7,8, 52-85 
Mixed phone setting 16,31,82 
mode 131 
modem 4,5,31,40,58,70,72,81,103,131 

See also Apple Modem 
attaching to Printer port 8,38,70,100,102 
answering the phone 87 
compatibility 87 
connecting 102-06,116 
during transmission 18 
giving commands to 87 
resetting after being turned off 87 

Modem phone setting 16, 31, 83 
Modem port 30,38,70,72-73,102,115 

hard disk connected to 88,102, 115 
Mode settings 11, 66 

N 
naming documents 55,64 

incoming file 58 
untitled 45 
saving with different name 55 

networks 40 
New file command 54 
New Line key equivalent 85 
New Line setting 11,12,30,36,37,69 
No Carrier message See carrier 
non printing characters setting 11 
Note Pad 22,24,36,53,131 
null parity See parity 
Number of Rings Before Answer setting 31 , 83 
numeric keypad 83-85,99,131 

o 
odd parity 10,70 See also parity 
off-line 67, 132 
OKbutton 30 
on-line 132 
On Line setting 11,67 
open 132 

MacTerminal document 45 
existing 45 
new 8,30,32 

received file 23 
text file 23 

Open command 7,8,23,45,54 
Option key 64,78,85,86,95,97,99, 111 , 132 
options See Settings menu 
Orientation, of printed document See Page Setup command 

Index 

p 
Page Setup command 44,59-60 
paper feed, for printing See Print Selection command 
paper settings, for printing See Page Setup command 
paragraphs and Return characters 23,75 
parallel 132 
parameters 132 See also communications parameters 
parity 10,71,132 

errors 71 
Parity setting 30,70, 71 
password 19, 106 
Paste command 8,22,63, 132 

sending with 22, 24,37,38 
transfer protocol 39 

pasting 
selections from terminal screen 22 
received data into an application document 43 

Pasting Text setting 13,73-74 
personal computer See communicating with and connection 
PF keys 84-85, III 
Phone menu 16, 18,31,81 
phone network 33 
phone number See access number 
phone operation and modems 87 
Phone port See Modem port 
Phone Settings 16, 18,31,32,82, 106 
phone system setting 16 
pin assignments for Apple Modem data cable 121 
pin-plug connector 102,115 
pin-socket connector 102,115 
ports 72-73, 133 
preset options 30,66-83 
primary character set 78 
Printer port 115 

hard disk connected to 88 
modem connected to 8,38,72-73,100 

printing received data 44 
print quality See Print Selection command 
Print Selection command 44, 61, 133 
print settings See Page Setup command 
problems in transmission See transmission problems 
prompt, of host computer 19,33,133 
protocol 133 See also transfer methods 
Protocol Convsetting 11 ,67 
Pulse phone setting 16,31,82 

Q 
Quit command 43,61 
quitting MacTerminal 43,45,61 
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R 
Receive button in dialog box 58 
Receive File command 15,18,32,58, 133 
receiving and saving information 14, 58, 64 
receiving and sending 

conventions 14 
problems See transmission problems 

receiving files 15,39,42,58,64,70,71,76 
recording 64 

a session 21 
data and saving 56 
screen information 22 

Record Lines Off Top command 14,21,22,31,42,63-64, 
75, 133 

rectangular boxes in incoming data See transmission 
problems 

regular characters 36 
remote computer 

role in communications network 40 
sending to 36 
settings 11 ,65-80 

remote diagnostic text mode VT100 feature 119 
Repeat Ctrls setting 11,69,70 
Reset command 21, 64 
Retain Line Breaks setting 13, 14,23,73,75 
Return 

S 

character 75 
in answerback message 77 
in transfer 15, 69 
restoring in text files 23 

key 97,99 
equivalent 85 
repeat setting 70 

Save command 46,55, 133 
Save As command 13,31,46,55 
Save Screens Before Clearing setting 13,14,22,31,42,64, 

73,75 
saving 
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communications parameters 8,40 
communications sessions 14, 31, 64 
communications settings 17, 31, 40 
documents See saving files 
document settings 46,55 
files 14,46,55,64 

before quitting 45 
on different disk 46 
previously untitled 56 
to application disk 42 

Index 

with new name 55 
incoming data 31 ,64 

as it scrolls off screen 42 
incoming documents 23 

Return characters 15 
Saving Lines Off Top settings 73,75 
screen display 22,57,64,113 See also display 
scroll area 134 
scroll bars 8,42,67,75, 134 
scrolling 65,67,75,133 

smooth scroll VT100 feature 119 
security 19 
Select All command 43,63 
selecting 134 

all data in document 43,63 
data to print 44 
documents in Finder 47 
part of a document 43 
screen data 22 
turning off selection 63 

Send button 35 
Send File command 24,39, 56 
sending 134 

and receiving data 33,65,70,73, 76 
conventions 14 
problems See transmission problems 

small amounts of text 36, 63 
errors 15,76 
files 24,31,34,39,57 

bytyping 39 
to Macintosh computer 34, 76 

stop sending 35 
tables offigures 34 
text files 74 

Sending Text settings 13,14,73-74 
send mode 33 
serial transmission 134 
setting features, of terminal 11 
Settings menu 20,22,30,38,65-80 
setting up MacTerminal document 30 
Show Clipboard command 63 
Show Tab Ruler/ Hide Tab Ruler command 80 
SOURCE, THE iv, 9 
space parity 71 
special keys 20 
speed, of transmission 14, 37, 38 See also baud rate 
starting a session 17,32,35,135 
start or stop bit See bits per character 
Start Scrolling command 65,71 
static on phone lines 89 
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Status Information Area, of IBM terminal display 113 
Status Lights setting 11 ,65,68, 135 
status line 113 
stop bit See bits per character 
stopping a transmission See communications session 
Stop Scrolling command 65,71 
Straight XModem transfer method 15,18,24,32,34,57,76 

See also transfer methods 
supervisor program See AppleLine supervisor program 
switching drives See Drive button 
SYLK files 13,76 
system file 135 

sending 38 
System Folder 7 

T 
tab 

characters 
in tables 43,62 

marker 135 
ruler 80,135 

Tab key repeat setting 70 
tables, copying 43,62 
Telenet 33 
telephone number See access number 
telex iv 
template document for communication session 88 
temporary files 64 
terminal 3, 135 

controls 110 
display area See screen display 
emulation 3,11,40,135 
identifier 33 
keyboard 83-85 
screen display See screen display 
selecting data 22 
setting features 11 , 65·80 
settings 11 , 30, 66· 70 
type 11,12,30,40,65,66,104,107 

advantages 24 
Terminal command 11,66, 104 
Terminal settings 38,66,104,117 
terminating a session See communications session 

and connection 
text files 13,35, 57,135 

opening 23 
sending 74,76 

Text transfer method 15,22,24,34,35,57, 76 
See also transfer methods 

Index 

THE SOURCE iv, 9 
tilde, key equivalent 20,95 
Tone phone setting 16, 31 , 82 
transfer 136 See also sending and communications session 

methods 15,24,58,73,76 
and transfer screen display 22 
andtypesoffiles 57,76 

progress gauge 22,35 
transmission See also sending and communications session 

preparing for 13,65-80 
problems 89 

transmit 136 
Transparent setting 70 
Trash icon 47 
troubleshooting 89·90 
T~ 3,11, 12,40,66,70,83, 136 
Tymnet 33 

U 
Underline cursor shape setting 66·67 
Undo command 8, 62 
Unlock Keyboard command 65,68 
uppercase letters 110 
U.S. ASCII character set 78 
U.S. Robotics Auto Link 212A 5,87 

V 
VAX computer 11 
viewing 

additional lines of IBM 3278 data 113 
data wider than screen 8,67 
previous screens of data 8, 75 
transferred files 22·3 

VT52 mode setting 66 
VT100 See DEC VT100 

W 
Wait for Call command 18,32,58,76,81 
Western Union Easylink iv 
width, of printed document 44 See also Page Setup command 
window 136 
Word Wrap Outgoing Text 34,37, 73 
Word Wrap setting 14 

X, Y,Z 
XModem Text transfer method 15 , 18,24,32,34,35,57, 76, 

136 See also transfer methods 
XModem transfer protocol See Straight XModem transfer 

method 
XOn/ XOff 10,30,65,70,71 ,129, 136 
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. '" Tell Apple About . .................... . 

• Please contact your authorized Apple dealer when you have 
trained by Apple Computer and are given the resources to h; 
you need the name of an authorized Apple dealer in your an 

• Would you like to tell Apple what you think about this produ 
product we would like to hear from you. You can help us to 
questionnaire below and marking the appropriate boxes on I 
have more than one response to a question, mark all the box 
Apple. Include additional pages of comments if you wish. 

1. What is your overall satisfaction with MacTerminal? (1 =poo 

2. How long have you used MacTerminai? (1 = less than 1 mon 

3. Where did you purchase MacTerminal? (1 =dealer, 2=softv 

4. What computer are you using with MacTerminal? (1 = Macinl 
4 =Macintosh XL, 5 =other) 

5. What modem are you using? (1 = 300/1200 Apple Modem,: 

6. Where is MacTerminalused most often? (1 = home, 2=wori 

7. What other computer system(s) do you contact with MacTen 
computer, 3 = company mainframe, 4 = bulletin board systel 

8. How easy is MacTerminal to use? (1 = difficult ... 6 = very ~ 

9. How did you learn to use MacTerminal? (1 = MacTerminal n 

10. Does MacTerminal meet your expectations? (1 =no, 2=yes 

11 What file transfer method do you use most often? (1 =Text, 
4=MacTerminal 1.1, 5=Straight XModem) 

12. What protocols would you like to see supported in future ve. 
3=MNP) 

13. How would you rate your satisfaction with the MacTerminal 

14. How easy was the MacTerminal manual to read and underst; 

15. Was the MacTerminal manual organized in a logical format? 

16. How easy was it to find the information you needed? (1 = di 

17. Were the illustrations useful? (1 = no, 2 = yes) 

~ 18. Which topics, if any, were confusing to you? 

19. Please describe any errors or inconsistencies you may have, 
numbers are helpful.) 

20. What suggestions do you have for improving MacTerminal? 

Thanks for your time and effort. 
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.~ Tell Apple About . ................................................................. .• 

• Please contact your authorized Apple dealer when you have questions about your Apple products . Dealers are 
trained by Apple Computer and are given the resources to handle service and support for all Apple products. If 
you need the name of an authorized Apple dealer in your area, call toll-free: 800-538-9696. 

• Would you like to tell Apple what you think about this product? After you have had an opportunity to use this 
product we would like to hear from you. You can help us to improve our products by responding to the 
questionnaire below and marking the appropriate boxes on the card at the right with a #2 lead pencil. If you 
have more than one response to a question, mark all the boxes that apply. Please detach the card and mail it to 
Apple. Include additional pages of comments if you wish. 

1 What is your overall satisfaction with MacTerminal? (1 =poor ... 6= excellent) 

2. How long have you used MacTerminal? (1 = less than 1 month, 2=2- 6 months, 3=over 6 months) 

3. Where did you purchase MacTerminal? (1 =dealer, 2=software store , 3 = department store, 4=other) 

4. What computer are you using with MacTerminal? (1 = Macintosh 128K, 2 = Macintosh 512K, 3= Macintosh Plus, 
4 =Macintosh XL, 5=other) 

5. What modem are you using? (1 =300/ 1200 Apple Modem, 2 =Apple Personal Modem, 3=other) 

6. Where is MacTerminal used most often? (1 =home, 2 = work, 3 = school, 4=other) 

7. What other computer system(s) do you contact with MacTerminal?(1 = information services, 2 = company mini­
computer, 3=company mainframe, 4 =bulletin board systems, 5=electronic mail systems) 

8. How easy is MacTerminal to use? (1 = difficult . . . 6 = very easy) 

9. How did you learn to use MacTerminal? (1 = MacTerminal manual, 2 = training class, 3=friend, 4=other) 

10. Does MacTerminal meet your expectations? (1 =no, 2=yes) 

11 . What file transfer method do you use most often? (1 = Text, 2 = Mac Binary, 3 = XModem Text, 
4 = MacTerminal 1.1 , 5 = Straight XModem) 

12. What protocols would you like to see supported in future versions of MacTerminal? (1 = Kermit, 2=X.PC, 
3=MNP) 

13. How would you rate your satisfaction with the MacTerminal manual? (1 =poor ... 6 = excellent) 

14. How easy was the MacTerminal manual to read and understand? (1 = difficult . . . 6 = very easy) 

15. Was the MacTerminal manual organized in a logical format? (1 =no, 2=yes) 

16. How easy was it to find the information you needed? (1 = difficult ... 6 = very easy) 

17. Were the illustrations useful? (1 =no, 2=yes) 

18. Which topics, if any, were confusing to you? 

19. Please describe any errors or inconsistencies you may have encountered with the MacTerminal manual. (Page 
numbers are helpful.) 

20. What suggestions do you have for improving MacTerminal? 

Thanks for your time and effort. 030-1369·A 
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e resources to handle service and support for all Apple products. If 
iealer in your area, call toll-free: 800-538-9696. 

about this product? After you have had an opportunity to use this 
u can help us to improve our products by responding to the 
priate boxes on the card at the right with a #2 lead pencil. If you 
mark all the boxes that apply. Please detach the card and mail it to 
ts if you wish. 

rminal? (1 = poor . . . 6 = excellent) 

'less than 1 month, 2=2- 6 months, 3=over 6 months) 

dealer, 2=software store, 3 = department store, 4 =other) 

inal? (1 = Macintosh 128K, 2 = Macintosh 512K, 3 = Macintosh Plus, 

Apple Modem, 2 =Apple Personal Modem, 3 =other) 

= home, 2 =work, 3 = school, 4 =other) 

act with MacTerminal?(1 = information services, 2 = company mini­
etin board systems, 5=electronic mail systems) 

ult ... 6 =very easy) 

=MacTerminal manual, 2 =training class, 3=friend, 4=other) 

(1 =no, 2 =yes) 

lften? (1 =Text, 2=MacBinary, 3 =XModem Text, 

ned in future versions of MacTerminal? (1 = Kermit, 2=X.PC, 

Ie MacTerminal manual? (1 = poor ... 6 = excellent) 

=ad and understand? (1 = difficult ... 6 = very easy) 

l logical format? (1 =no, 2=yes) 

needed? (1 = difficult ... 6 = very easy) 

s) 

;; you may have encountered with the MacTerminal manual. (Page 

: MacTerminal? 

030-1369-A 
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Please Do Not Mark Above This Line 
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- 10. IT] CD 
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- 12 . IT] UJ [TI 
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- 14 . IT] UJ [TI [TI IT] [TI 

- 15 . IT] UJ 

- 16. IT] UJ aJ [TI D:J [TI 

- 17 . IT]UJ 

- 18. ______________________________ ___ 

11 19 ______________________________ ___ 

- 20 . __________________________________ __ 
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LimitedW 
on Media a 
Replaeem 

This book's binding lets it lie 
flat while you're working 
with your Macintosh. When 
you're using the book, keep 
the wraparound end flap 
tucked inside the back cover. 
To make it easy to spot the title 
when the book's on a shelf, 
fold the flap inside the front 
cover and set the book on the 
shelf with the title visible. 



Limited Warranty 
on Media and 
Replacement 

If you discover physical defects in the manuals distributed with an Apple 
product or in the media on which a software product is distributed, Apple will 
replace the media or manuals at no charge to you, provided you return the item 
to be replaced with proof of purchase to Apple or an authorized Apple dealer 
during the 90-day period after you purchased the software. In addition, Apple 
will replace damaged software media and manuals for as long as the software 
product is included in Apple's Media Exchange Program. While not an 
upgrade or update method, this program offers additional protection for up to 
two years or more from the date of your original purchase. See your authorized 
Apple dealer for program coverage and details. In some countries the 
replacement period may be different; check with your authorized Apple 
dealer. 

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING 
IMPLIED WARRANTIES OF MERCHANTABILIlY AND FITNESS FORA 
PARTICUIARPURPOSE,ARELIMITEDINDURATIONTONINElY (90) DAYS 
FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT. 

Even though Apple has tested the software and reviewed the documentation, 
APPLE MAKES NO WARRANlY OR REPRESENTATION, EITHER EXPRESS OR 
IMPLIED, WITH RESPECT TO SOFTWARE, ITS QUALIlY, PERFORMANCE, 
MERCHANTABILIlY,ORFITNESSFORAPARTICUIARPURPOSE.ASA 
RESULT, THIS SOFTWARE IS SOLD "AS IS," AND YOU THE PURCHASER ARE 
ASSUMING THE ENTIRE RISKAS TO ITS QUALIlY AND PERFORMANCE. 

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY 
DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the 
possibility of such damages. In particular, Apple shall have no liability for any 
programs or data stored in or used with Apple products, including the costs of 
recovering such programs or data. 

THEWARRANlYAND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No Apple 
dealer, agent, or employee is authorized to make any modification, extension, 
or addition to this warranty. 

Some states do not allow the exclusion or limitation of implied warranties or 
liability for incidental or consequential damages, so the above limitation or 
exclusion may not apply to you. This warranty gives you specific legal rights, 
and you may also have other rights which vary from state to state. 
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